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About this Manual

This document was created for the product having the following design specifications.

� TM-D710A/E, RC-D710, MCP-2A Version 3.10, 3rd party external GPS unit and Weather 

Station.

� TM-D710A/E and RC-D710 with firmware version 2.00.

Software License Notice

� Users are required to obtain approval from Kenwood, in writing, prior to redistributing this 

document on a personal web page or via packet communication. 

� Users are prohibited from assigning, renting, leasing or reselling the document. 

� Users are prohibited from revising, changing, translating, merging, de-compiling or reverse 

engineering the software. 

� Kenwood shall own all copyrights and other intellectual properties for the software and all 

manuals and documents attached to the software. The user shall be allowed to use, not to 

resell, the software by obtaining a license from Kenwood.  While the media on which the 

software is stored is possessed by the user, the ownership of the software itself shall be 

reserved for Kenwood. 

� Kenwood does not warrant that quality and functions described in this document comply with 

each user’s purpose of use of this document and, unless specifically described in this 

document, Kenwood shall be free from any responsibility for any defects and indemnities for 

any damages or losses.  The selection and introduction of the document, as well as the results 

therefrom, shall be solely a liability of the user. 

Firmware Copyrights

The title to and ownership of copyrights for firmware embedded in Kenwood product memories are 

reserved for Kenwood Corporation.  

Any modifying, reverse engineering, copying, reproducing or disclosing on an Internet website of 

the firmware is strictly prohibited without prior written consent of Kenwood Corporation.  

Furthermore, any reselling, assigning or transferring of the firmware is also strictly prohibited 

without embedding the firmware in Kenwood product memories.
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PROLOGUE

Amateurs Building the New Global Communications Network

Hams have enjoyed using FM transceivers for years for SSTV, ATV, packet, satellite, EME, GPS 

and other communications modes.  A fundamental reason for this has been that FM transceivers 

are easy to use.  Recently, personal computers and the Internet have combined to offer global 

communications opportunities.  Yet, with their long history of communicating using various 

methods, nobody is better prepared than hams to embrace and take advantage of these new 

communications techniques to create an even more interesting new global network.

No longer are users of FM transceivers bound by line-of-sight distances and local same-city 

coverage.  The Internet now shrinks the vast distances to other operators who were once out of 

reach by using only an FM transceiver.  People now meet, experiment and interact worldwide via 

voice and data communications using low-power FM transceivers.  These networks built by 

individual hams connecting through gateways into the Internet are allowing others to share the 

experience that this infrastructure offers. 

And the networks are growing in size day-by-day.  Hams are using basic FM transceivers to 

communicate on a direct one-on-one basis with operators across the globe.  Besides hobby 

applications, such a communications network also has tremendous capability to deliver a powerful 

tool to serve the general public in times of emergencies.

APRS Action

Complementing these voice and data activities is the Automatic Packet Reporting System, 

commonly called APRS.  Mr. Bob Bruninga WB4APR created APRS back in 1992.  Since those 

days of first meeting with Bob, Kenwood married radio and GPS technology and our company 

developed APRS products over the years.

In the beginning, the TM-V7A/E was popular for use with APRS because the transceiver 

supported data communications on a separate band from voice communications.  But the Internet, 

personal computers and electronic mapping technologies were all in their infancies compared to 

now.  It has taken a great deal of research for us to create the current TM-D710A/E and the 

environment has changed over the years.  Besides the basic technology maturing, it is now 

possible to use EchoLink over VoIP.  This means you can plot stations from the other side of the 

planet on a map while sending mail and communicating with them by voice.  These are exciting 

new activities that didn’t exist in 1992.
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New Technology Expands Amateur Radio Versatility

Using HF radio to call CQ and contact hams around the world will never lose its appeal.  But there 

is elegance in being able to communicate with only an FM transceiver and by adopting the latest 

technology.  The global network will only get more interesting as it evolves with new ideas as a 

result of those like you becoming involved.  Already, APRS plots locations of amateur radio 

satellites and presents weather information such as hurricane data on screen.  APRS accurately 

tracks your traveling amateur radio friends.  You can send email directly to them or take 

advantage of EchoLink node numbers to make direct voice contact.  Combining the different 

technologies will add to your communications versatility and make you a part of the 

communicating world.
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1  DEVELOPMENT CONCEPT
The concept of developing the TM-V71A/E, TM-D710A/E and RC-D710 is as stated below.

� To have common functionality between the basic model (TM-V71A/E) and the multi-function 

model (TM-D710A/E) transceivers.

� To add the capability for customers themselves to be able to update the version of APRS on 

their own. 

� To create an affinity with VolP systems. 

In order to understand customer requirements, we did surveys at various ham shows, such as the 

Dayton Hamvention, ARRL and TAPR Digital Communications Conference (DCC), JARL Ham 

Fair (Japan), Ham Radio in Friedrichshafen (Germany), etc., and analyzed our customers’ needs.  

The many ideas gathered coalesced into the development concept above as the Product Planning 

group and Development group virtually merged during the conception phase to come up with the 

present development program.

1.1 Strategy for the Design

First, we looked back at the makeup of the earlier TM-D700 model series.  The TM-D700 series has 

built-in TNC modems in the transceivers themselves for packet communication.  The embedded 

microcomputer supports not only amateur radio functions, but also data communication application 

programs such as APRS.

After the multi-function TM-D700 model was marketed, we eliminated hardware parts related to 

packet communication and introduced the TM-V708 as a standard model.  From the beginning, 

this model was developed as a multi-functional model; therefore, it was easy to update the design.  

However, it was difficult to cut costs while developing the standard model.

This time there was a plan to develop two types: a standard model and a multi-functional model.  

We discussed which type we should develop first, and slowly the following plan evolved:

1. First, develop the standard model.

2. Next, create a multi-functional model only by switching the front panel.

3. Lastly, develop a standalone front panel.

Nobody could imagine how this development would proceed, especially to progress from Step 2 to 

Step 3.

On the basis of sharing functions between the multi-function model and the standard model 

transceiver, the research to combine the TNC modem and APRS application program all in the 

front panel was completed.

At this stage, our goal to have a TNC with APRS functionality was realized.  We merchandised the 

standalone front panel with the underlying concept of allowing existing Kenwood customers to 

enjoy the benefits of APRS.
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1.2 Evolving Development

In order to develop an APRS model following the TM-D700 series, we discussed face-to-face 

directly with Mr. Bob Bruninga, developer of APRS, an operation specification to better implement 

the flexibility of the APRS protocol.  We were going to “kick it up a notch” and make APRS still 

more powerful.

We enhanced capability with several new important APRS functions on top of the basic functions 

of the TM-D700 series:

� Added the capability to connect to weather observation devices and send weather information.

� Substantially increased the number of stations in the station list and message list.

� Included various sorting functions for finding information in the station list.

� Developed a proportional pathing function that reduced on-air traffic loading.

� Introduced a menu-configurable Digipeat function.

� Added the voice frequency to outgoing packets.

� Added display of the voice frequency on incoming packets.

The lists of ideas generated from these meetings were endless.  In the future, we will endeavor to 

develop more new features and turn the ideas into reality via version upgrades.

1.3 Affinity with VoIP

We closely studied EchoLink since this system has the greatest number of amateur radio operator 

users of any VoIP system currently in use.  Our studies indicated that a mobile station was the 

most convenient method for access to the EchoLink system.  Also, the concept of a fixed node 

number per each station using the EchoLink system was fundamental.

In order to connect the amateur radio equipment to a computer more simply, we re-developed the 

interface cable, too.  This interface improvement made the system more robust.

The merging of APRS and VoIP has great potential for the future of ham radio.  The APRS 

network knows where everyone is by callsign.  The EchoLink network knows how to connect 

distant FM transceiver users via VoIP.  Future merging of these technologies should be able to 

allow end-to-end voice links anywhere on earth by a simple APRS message request by callsign 

alone.  Think of it as ham radio’s cell phone system.

We believe the TM-V71A/E, TM-D710A/E and RC-D710 give the potential to the amateur radio 

community to evolve into this future network.
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2  APRS OPERATIONS written by Bob Bruninga, WB4APR

2.1 APRS Overview

2.1.1 History

APRS was developed beginning back in the 1980s by Bob Bruninga, WB4APR, as a real-time 

local tactical communications system for rapidly exchanging digital data of immediate value to 

local operations.  This really took off when GPS became available and MAPS were integrated into 

the system for tactical situational awareness of everything in the net.  Unfortunately, in the 13 

years since GPS became readily available to most operators and was added to APRS to facilitate 

the display of the local network, too many follow-on applications have focused too heavily on the 

vehicle tracking function at the expense of many of the more valuable functions of APRS for 

human-to-human ham radio information exchange in real time.

As a result, too many operators appear to misunderstand some of the basic tenets of APRS.  

APRS is not a vehicle tracking system.  The Automatic Packet Reporting system is simply a local 

data channel designed to share everything that is going on in ham radio in real time.  This channel 

was designed to support rapid, reliable exchange of information for local, tactical real-time 

information, events or nets.  The concept, which dates back to the mid 1980s, was to provide a 

single information resource channel where everything happening could be beaconed and where 

anyone could monitor to find out what was going on across all aspects of ham radio interests.

2.1.2 Local Information Exchange

A fundamental principal was that all relevant information is transmitted immediately to everyone in 

the net and every station captures that information for consistent and standard display to all 

participants.  Information was refreshed redundantly but at a decaying rate so that new information 

was rapidly disseminated but old information was updated less frequently than new info.  Since the 

primary objective is consistent exchange of information between everyone, APRS established 

standard formats not only for the transmission of POSITION, STATUS, MESSAGES, and 

QUERIES, it also establishes guidelines for display so that users of different systems would still 

see the same consistent information displayed in a consistent manner (independent of the 

particular display or mapping system in use). 

To emphasize the freshness and importance of local information over the sometimes interference 

of older and more distant data, the new TM-D710A/E implements both the decay algorithm and 

also the new proportional pathing algorithms.

THE GOAL IS COMMUNICATIONS and LOCAL INFO UPDATE, -NOT- JUST VEHICLE TRACKING! 
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2.1.3 Mobile Information Resource

APRS was never intended to be just a vehicle tracking system (GPS was added in the 1992 time 

frame when GPS became affordable).  APRS is much more.  See the Kenwood mobile display 

below.  This is the STATION LIST which shows the nearest 100 stations heard.  In this case, not 

only are the two stations of AB9FX nearby, but also his current voice operating frequency is 

visible.  Also, we can see that this transceiver is in operating range of three voice repeaters that 

are also identifying themselves as objects on APRS as the locally recommended voice operating 

channels. 

Figure 2-1   TM-D710A/E Front Panel showing Station List

2.1.4 Situational Awareness

APRS provides situational awareness to all operators of everything that is going on in his local 

area, whether it is weather reporting, traveler info, direction finding, objects pointing to EchoLink 

and IRLP, or traffic reporting and emergency response.  All of this while providing not only 

instantaneous operator-to-operator keyboard messaging capability for special events, but also an 

always-on Voice Alert backchannel between mobiles in simplex range.  There is even an APRS 

interface to the Winlink system called APRSLink so that mobiles can send and receive email 

without needing a PC.  Think of APRS as a signaling channel to reveal all amateur radio resources 

and live activities that are in range of the operator at any instant in time. 

2.1.5 Participation

Although APRS offers phenomenal capabilities for managing and displaying local information, an 

overarching design assumption was that in most applications, APRS would not be used by most 

operators at an event or by every member of a club, and very few devices could actually report 

their own position.  The design assumption was that manual entry and management of large 

numbers of objects would be a major function of APRS and APRS operators in order to fully 

represent the situation.  Further, Bulletins and Announcements would keep everyone informed of 

the same information at the same time.  Operator Messages would communicate important 

information in the background without encumbering voice nets.
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2.2 Ubiquitous Operations

Consistent with providing information on all resources within range, APRS must also work across 

all boundaries and in all areas of the continent for all travelers.  For this reason, 144.39 MHz is 

dedicated to APRS throughout North America.  Other continents have similar single frequencies 

such as 144.80 MHz in Europe and 145.175 MHz in Australia.  Also, after 14 years of evolution, 

APRS was greatly simplified beginning in the 2004 time frame to eliminate obsolete and inefficient 

routing.  See the New-N Paradigm. 

Now, there is only one recommended PATH everywhere, and it is VIA WIDEn-N for fixed stations 

where N is usually 2 in most metropolitan areas and no more than 3 in very remote or isolated 

areas far from cities.  Mobiles can use a path VIA WIDE1-1,WIDE2-1 in those 2-hop areas to gain 

help from nearby WIDE1-1 fill-in digipeaters.  See the high density areas in the map below: 

This data from Steve Dimse’s FINDU is plotted on APRSdos to show the user density in the 

USA in February 05.  Although it appears that most of the USA is low density, remember that a 

WIDE5-5 launched anywhere in the remotest area will still get to the cities and add to the 

QRM there.  And there are 100 times more low density users surrounding these cities on all 

sides that really adds up to heavy QRM.  We recommend WIDE2-2 in the 8 per degree or 

more and surrounding areas. 3-3 should be used only in the 5 per degree or less areas. 

The grid size is 30 miles and each is averaged with all 8 of its surrounding adjacent grids.  The 

file is over 11,000 stations.

But the great news is that the New n-N Paradigm is the right approach.  It encourages 

WIDEn-N everywhere while letting the high density areas trap large values of N to prevent 

overload in their areas only.

Figure 2-2   APRS User Density

2.3 APRS Global Internet System

Although APRS is a local, tactical real-time two-way communications system, the enormous free 

bandwidth of the Internet was added in the mid 1990s to allow global monitoring of all real-time data 

from all local communities around the world.  Everything on any APRS frequency is being monitored 

locally and fed globally into the APRS internet system by hundreds of IGates.  See live list 

(complete) or a Map of I-G symbols.

Not only does this allow for global monitoring of any local activity, it also allows two-way point-to-

point messaging between any two APRS users anywhere on the planet (that has an APRS 

infrastructure).  Think of it as everything goes in, so it is available to everyone, but the only things 

that come from the Internet back to local RF are messages and selected position data requested 

locally. 
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2.4 Kenwood Contributions

Kenwood has developed its series of transceivers, the TH-D7A/E, TM-D700A/E and TM-D710A/E 

to best support the original objectives of APRS.  The display of APRS information on the front 

panel of these transceivers gives the mobile operator instantaneous access to all local information 

being provided on the APRS channel about all surrounding ham radio activities.

There are many APRS clients and programs that have been written that sometimes have 

concentrated too much on the display of maps and vehicle positions while leaving out much of the 

original fundamentals of APRS and the efficiency of the APRS network in support of two-way local 

area communications.  The Kenwood transceivers have avoided that simplistic approach to APRS 

by implementing a rich and full feature set that includes most of the original APRS features that 

enhance this local information distribution concept.  The Kenwood transceivers are not just 

Vehicle Tracking Systems, but are designed to be Real-Time Information Distribution Systems for 

mobile operators with these features:

� Position Entry: The transceivers are not dependent on GPS for their value since manual 

position entry and 5 common positions can be saved.

� Map Displays on attached GPS: Although these transceivers provide Map plotting via 

attached NMEA GPS units with map displays, the radios are fully functional without maps and 

can display on their front panel all aspects of bulletins, messages, weather, as well as 

information on the direction and distance to others including their antenna heights and gain.

� APRS Network Fundamentals: Kenwood fully implemented the more subtle aspects of the 

APRS fundamentals that assure optimum network efficiency and channel sharing among all 

users.  The new TM-D710A/E transceiver supports the decay algorithms and proportional 

pathing.  These two techniques provide good refresh rates for new and local information while 

minimizing the network impact of old and distant data.

� Objects: The Kenwood transceivers fully appreciate the value of APRS objects and display 

them prominently.  The object location is shown just like other stations either on the attached 

map display or on the front panel with distance and range.  These objects are what give APRS 

the local information value to local users.

� Two-Way Messaging: Unlike passive one-way tracking devices, the Kenwood transceivers 

provide the mobile user with full two-way messaging and display.  This real-time human-to-

human communications is what makes APRS so valuable in support of special events and 

emergencies.

� Field Data Entry: Although the Kenwood transceivers are excellent field data display devices, 

their menus have also been designed for easy data, position and message entry.  Often 

overlooked is the ability to use a number of TH-D7A/E or even TM-D700A/E transceivers as 

excellent field data entry and clipboard entry devices at many field events.  See http://

www.ew.usna.edu/~bruninga/aprsevent.html.

� Individual Information Access: The Kenwood individual radio displays enhance the 

distribution of ham radio information to a large number of users by giving them individual front 

panel and key pad access to all of the online APRS data.  A common mistake of fixed 

operations with computers is the use of large display screens for large groups to see but which 

fails to recognize that each individual viewer actually needs access to the keyboard to truly 

access the individual APRS information he may need at any instant.  The individuality of APRS 

radios with individual displays spreads this data access throughout the field.

� Overlay Characters on all Symbols: Although the Kenwood transceivers have always 

displayed the overlay character of a subset of APRS symbols, the new TM-D710A/E has vastly 

expanded the APRS symbol set by not only adding additional symbols, but more importantly 

displaying and allowing the addition of an Overlay character on almost all APRS symbols.  This 

provides hundreds of new symbol combinations for better APRS application to new uses.

http://www.ew.usna.edu/~bruninga/aprsevent.html
http://www.ew.usna.edu/~bruninga/aprsevent.html


2 APRS OPERATIONS written by Bob Bruninga, WB4APR

TM-D710A/E CONTENTS 7

� Mobile Digipeating: The new TM-D710A/E Kenwood mobile has additional features to help 

local sysops manage the local APRS network.  Each transceiver now has front panel access to 

the digipeater function so that it can be turned on and off as needed to match the local situation.  

In addition, each TM-D710A/E is pre-configured to serve automatically as a TEMPn-N 

digipeater in support of emergency operations when a user is having difficulty accessing the 

existing WIDEn-N network.

� Voice Operating Frequencies: The most important new feature of the new TM-D710A/E 

transceiver is the recognition of the value of operator frequency as a fundamental local 

communications parameter.  Not only does the transceiver automatically include its own 

operator frequency in every position packet, it also has a new display column to display that 

information as it is collected from other similar operators.  Further, the transceiver can tune to 

these frequencies for a quick QSO with a single press of the TUNE Button.

� EchoLink, IRLP and WinLink Frequencies: In addition to all other stations, information and 

objects, the new TM-D710A/E can automatically tune to nearby EchoLink, IRLP or WinLink 

frequencies with the push of a single button.  If the packets for these local objects contain the 

frequency of these nodes, then the TM-D710A/E TUNE button will QSY instantly if needed.

� Voice Alert:  Voice alert is like a 3rd simultaneous radio channel on the Kenwood APRS 

transceivers.  It acts like an intercom channel for all APRS operators to be able to quickly raise 

another nearby APRS voice alert station by a simple direct voice call.  Although this “3rd” 

intercom channel appears to be independent of the data channel and voice channel, it is simply 

the sharing of the data channel for data and seldomly-made voice calls by separating them with 

CTCSS tones.  All network data on the APRS channel is transmitted without CTCSS tones, and 

so the TONE squelch can be used to silence the speaker of all packet noise, yet still provide a 

voice simplex calling channel between APRS operators if needed.  The APRS CTCSS tone is 

100 Hz.  Refer to section 6.1.6.2 Receiving QSY Information.

2.5 APRS in the Field

The photo below shows the typical APRS set up in the field at an event.  This station can be used 

to not only show other personnel at the checkpoint the tactical situation, but it keeps the APRS 

operator at this site informed.

Figure 2-3   Field Setup for APRS
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2.6 Other Data Entry Stations

But we should not lose sight of the home station that can also be used as a great information 

resource.  The next photo shows a station that was set up in a motel room and the operators there 

could monitor all of the activities on the various nets and enter this situational information into their 

APRS PCs.  All of this data would show everywhere on APRS.  AND, through the miracle of 

wireless (ham radio), they do not have to be at the site.  They can be anywhere convenient, just 

monitoring, and managing the data.

Figure 2-4   APRS at Home or any Fixed Location

REMEMBER: If you are not using the full potential of APRS, it is not the fault of the protocol or the hardware.  APRS is 
a communication tool, not just an automated map....use it.  But in most cases, that means ENTERING 
DATA, not just watching it. 
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3  PREPARATIONS FOR USING APRS

3.1 What Do I Need to Configure?

The following need to be configured before beginning to operate TM-D710A/E or RC-D710 with 

APRS.

� Built-in Clock

APRS data will be stamped with date and time, therefore the built-in clock must be set.

� MY CALLSIGN

The station configured for MY CALLSIGN will be used as the originating station when APRS 

data is sent.  You cannot send any data using NOCALL.

� BEACON TYPE

Use BEACON TYPE to select APRS data format for sending.

� Position

Your station’s position is added to APRS data, therefore you must configure your latitude and 

longitude.  You can get your own position also from GPS.

� Frequency

The operating frequency will depend in what region of the world you are operating.  You can 

begin operating using the frequency configured for the data band as follows:

North America: 144.390 MHz, Europe: 144.800 MHz, Australia: 145.175 MHz, 

New Zealand: 144.575 MHz, Argentina: 144.930 MHz, Brazil: 145.570 MHz, Japan: 144.640 MHz

3.2 Configuration

Follow the explanations below to configure each item listed in the previous section.

3.2.1 Built-in Clock

Select Menu 524 (AUX - DATE) and configure the date.

� K-type (U.S.A. and Canada): Set month, date, year in this order.

� E-type (Europe): Set date, month, year in this order.

Note: If using RC-D710, then set month, date, year regardless in which region you are located.

Example:

Configure the date May 16, 2008 (K-type).  Refer to Figure 3-1.

Figure 3-1   Menu 524 (AUX - DATE)
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Select Menu 525 (AUX - TIME) and configure the current time.

Example:

Configure the time 12:00.  Refer to Figure 3-2.

Figure 3-2   Menu 525 (AUX - TIME)

Select Menu 526 (AUX - TIME ZONE) and configure your time zone.

3.2.2 MY CALLSIGN

Select Menu 600 (APRS - BASIC SETTINGS - MY CALLSIGN) and configure your own callsign.

Example:

Register the callsign W6DJY.  Refer to Figure 3-3.

Figure 3-3   Menu 600 (MY CALLSIGN)

3.2.3 BEACON TYPE

Select Menu 600 (APRS - BASIC SETTINGS - BEACON TYPE) and configure the beacon type.  

Select APRS format to send APRS.

Note: Weather information and messages will be sent by APRS format regardless of beacon type setting.

Example:

Configure the beacon type as APRS.  Refer to Figure 3-4.

Figure 3-4   Menu 600 (BEACON TYPE)
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3.2.4 My Position

3.2.4.1 Activating Your Mobile GPS Position

Select Menu 602 (APRS - GPS PORT) and configure the GPS terminal settings.

� Baud Rate: 4800 bps (same as GPS receiver)

� Input: GPS (for the GPS receiver)

� Output: OFF (when WAYPOINT, DGPS are not used)

Figure 3-5   Menu 602 (GPS PORT) with GPS Receiver

3.2.4.2 Entering Your Position Manually

Select Menu 602 (APRS - GPS PORT) and configure the GPS terminal settings.

� Input: OFF

Figure 3-6   Menu 602 (GPS PORT) without GPS Receiver

Select Menu 605 (APRS - MY POSITION) and configure your own station’s position.

� Name: Enter a familiar name for your location (HOME or etc.).

� Latitude: Enter the latitude value.

� Longitude: Enter the longitude value.

Example:

Configure a latitude of N 39° 49.31’ and a longitude of W 84° 15.39’.  Refer to Figure 3-7.

Figure 3-7   Menu 605 (MY POSITION)



3 PREPARATIONS FOR USING APRS

12 CONTENTS TM-D710A/E

3.2.5 Setting the APRS Channel

Example:

Configure a frequency of 144.390 MHz.  Refer to Figure 3-8.

Figure 3-8   Operating Frequency 



TM-D710A/E CONTENTS 13

4  GPS

4.1 What is GPS?

GPS, standing for Global Positioning System, is becoming common nowadays.  Following is a 

brief introduction.

The American Defense Department developed GPS originally for military operations.  The system 

is available for use by the general public.  For example, anybody can use GPS in association with 

modern vehicle navigation systems.  Position precision for public use is approximately 15 m.  

Moreover, precision can be improved when used for vehicle navigation and aboard ships through 

use of map matching technology and differential GPS techniques.

A total of 24 GPS or more satellites are at a high-level altitude of approximately 20,000 km on six 

circular tracks with orbital radii of approximately 26,000 km.  Therefore, there are four or more 

satellites located in each orbital track.  For civilian use, the RF carrier frequency of the satellites is 

1575.42 MHz.  Spread spectrum (SS) technology is used over a bandwidth of 2.046 MHz to 

prevent interference among all the satellite signals on a common carrier frequency.  Due care 

must be taken when installing amateur radio equipment and antennas for use on the 430 MHz or 

1200 MHz bands to prevent from interfering with GPS signals.

Figure 4-1   GPS IIR Satellite in Orbit

4.1.1 Position Determination Principle

The GPS receiver receives the radio signals transmitted from the GPS satellites.  The receiver 

measures the time duration between when the signal leaves the satellite and when the signal 

arrives at the GPS receiver.  Knowing this time allows calculation of the distance that the signal 

traveled from that particular satellite.  By receiving multiple signals from different satellites and 

doing this distance calculation multiple times, the intersection of the spherical surfaces that 

represent the respective radius distances to the various satellites will determine a single point.  

The precision of the determination of the intersecting point relies on the satellites and the data 

collected.
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4.1.2 Datum (Geodetic Survey System)

The latitude and longitude information required by the GPS receiver does not allow for accurate 

representation of the unevenness of the Earth’s surface.  For use with GPS, the current standard 

that defines the precise shape of the Earth is called WGS-84.  By using this standard in 

conjunction with mapping standards for each country, accurate position plotting on a map can be 

done.

4.1.2.1 GPS and APRS Position Format

Although position can be described in many different formats, such as degrees, degrees and 

minutes, and degrees, minutes and seconds, the GPS system and APRS have standardized on 

the degrees and decimal minutes format.  Just like it is important to use proper international 

phonetics when spelling on the air, it is important in APRS as in any communications system to 

have a default standard for position.  All operators should be trained to use the DDD MM.mm 

format by default in voice communications just like in the data formats.  Using these standards on 

the air will prevent communications errors, confusion, repeats, and conversions.

APRS Standard:

Geographic 

Coordinates
Format Example

Latitude
DD MM.mm 

(degrees and minutes)

39 49.31N 

+39 49.31

Longitude
DDD MM.mm 

(degrees and minutes)

84 15.39W 

-84 15.39
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4.2 GPS Receivers

Figure 4-2   GPS Receivers

4.2.1 Garmin GPS18PC

The GPS18PC is a GPS module receiver that interfaces via a 9-pin D-SUB RS-232C serial port.  

Refer to the wiring example using an accessory cable (2.5mm 3-conductor plug) that comes with 

the TM-D710A/E.  Power is sourced from the 12VDC supplied from a vehicle cigarette lighter 

socket.  Because there is no screen, you cannot use the Waypoint function.

Figure 4-3   Garmin GPS18PC

4.2.2 AvMap G5

The AvMap G5 comes with a Kenwood-ready cable and exclusive APRS interface built right into 

the panel.   You can watch APRS activity on the AvMap G5 screen without having a PC.  It can be 

also configured to navigate to your favorite APRS station. 

4.2.3 Other GPS Receivers

The GPS receiver used must be based on NMEA 0183 format (http://www.nmea.org).  

The following RS-232C singal levels are allowed for using the TM-D710A/E and RC-D710.  

Low level: - 15 V to 0.5 V, High level: +3.0 V to +15 V.  You cannot use a GPS receiver with 

USB-type connector.

4.2.4 Settings for Geodetic Survey System

For APRS, always configure the WGS-84 Geodetic Survey System for your GPS receiver.

GPS without Maps (GPS18PC or similar)

To GPS jack

Weather Station

GPS with Maps (AvMap G5)

Shield

Red

White

5 3 2
GND

RXD

TXD

Viewed from soldering side 

(DB-9 connector (Male)) 

http://www.nmea.org
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5  APRS SOFTWARE FOR YOUR PC

5.1 UI-View

5.1.1 Introduction to UI-View

UI-View32 is APRS client software designed to allow a personal computer to display APRS 

stations on a map and to use various APRS functions such as Internet gateway access.  So you 

can display on a map on your computer the APRS stations received by a TM-D710A/E and, in 

addition, connect to an Internet gateway.  In doing so, APRS allows access to a much larger set of 

stations.

To start, you will require a UI-View32 registration number (Registration No.) and a certification 

number for the APRS server (Validation No.).  Go to http://www.ui-view.org/ to download the latest 

version of UI-View32 software, to register and to obtain detailed setting and usage information.

Note: The above URL link is subject to change.  If the link is broken, search for “UI-View32” using your favorite Internet 
search engine to quickly locate the appropriate home page.

Figure 5-1   APRS Stations Display

http://www.ui-view.org/
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5.1.2 Connecting a PC

Use the optional PG-5G programming cable to connect the COM port on the rear of the 

TM-D710A/E operation panel to the serial port on your personal computer.

Figure 5-2   

5.1.3 Creating a CMD File for TM-D710A/E

To use TM-D710A/E with UI-View32, you must create an initialization file.  Look in the UI-View32 

CMD folder and you will find an initialization file called TM-D700.CMD.  This file was required to 

connect to the earlier TM-D700A/E transceiver.  You need to edit this file as shown below and 

create a new file for the TM-D710A/E.

TM-D710A/E Initialization File

Save the newly created initialization file as TM-710.CMD in the CMD folder under UI-View32.  You 

can then select “TM-710” as the TNC type in the Comms Setup screen of UI-View32 and start 

operating.

Note: TM-D700.CMD initialization file cannot be used for TM-D710A/E due to the incompatibility of the PC commands.  
Modify the TM-D700.CMD file using a text editor as above and save it as TM-D710.CMD.

;This is a sample TNC initialization file for use with

;the Kenwood TM-D710A/E.

[SETUP]

;DON'T alter anything in this section unless you are

;sure you know what you are doing!

COMMAND_PROMPT=cmd:

COMMAND_CHARACTER_CODE=3

ESCAPE_CHARACTER_CODE=

CONV_COMMAND=CONV

MYCALL_COMMAND="MYCALL "

UNPROTO_COMMAND="UNPROTO "

NO_BEACON_COMMAND=BEACON EVERY 0

[INIT_COMMANDS]

^C^C^C

;Control mode on.

TC 1!TS 1

;Select TNC PKT mode on A band.

TN 2,0!TN 2,0

;Waiting for command prompt.

^M!cmd:!5

;Repeating the first two commands is not an error!

ECHO OFF

BEACON EVERY 0

ECHO OFF

BEACON EVERY 0

PG-5G
To PC 9-pin

D-SUB terminal
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5.2 Available APRS-related Software

The APRS program currently runs on a number of platforms.  These programs are constantly 

being updated and can be downloaded from the Internet.  Most programs are shareware and the 

latest versions are available at the TAPR (Tucson Amateur Packet Radio) FTP site: ftp://

ftp.tapr.org/aprssig.

APRSdos  (ftp://ftp.tapr.org/aprssig/dosstuff/APRSdos)  

Written by Bob Bruninga, WB4APR, the Father of APRS

Runs on MS-DOS.

MacAPRS  (ftp://ftp.tapr.org/aprssig/macstuff/MacAPRS) 

Written by Mark Sproul, KB2ICI and Keith Sproul, WU2Z

Runs on Macintosh computers using Operating System 7 or higher.

WinAPRS  (ftp://ftp.tapr.org/aprssig/winstuff/WinAPRS) 

Written by Mark Sproul, KB2ICI and Keith Sproul, WU2Z

Runs on Windows 95 or higher, or on Windows 3.1 + Win32s.

javAPRS  (ftp://ftp.tapr.org/aprssig/javastuff) 

Written by Steve Dimse, K4HG

Runs on JAVA.

APRSplus  (ftp://ftp.tapr.org/aprssig/winstuff/APRSPLUS) 

Written by Brent Hildebrand, KH2Z

Runs on Windows 95 or higher, or on Windows 3.1 + Win32s.

UI-View  (ftp://ftp.tapr.org/aprssig/winstuff/UI-View) 

Written by Roger Barker, G4IDE SK

AGWTracker  (http://www.agwtracker.com) 

Written by George Rossopulos, SV2AGW

Note: The above URL links are subject to change.

ftp://ftp.tapr.org/aprssig
ftp://ftp.tapr.org/aprssig
ftp://ftp.tapr.org/aprssig/winstuff/UI-View
http://www.agwtracker.com
ftp://ftp.tapr.org/aprssig/dosstuff/APRSdos
ftp://ftp.tapr.org/aprssig/macstuff/MacAPRS
ftp://ftp.tapr.org/aprssig/winstuff/WinAPRS
ftp://ftp.tapr.org/aprssig/javastuff
ftp://ftp.tapr.org/aprssig/winstuff/APRSPLUS
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6  APRS IN ACTION
While monitoring APRS stations from around the world that may appear on your map, you can 

easily send messages to them.  An interest is now growing in APRS QSOs where one station may 

call CQ looking for responses in the conventional style of a ham contact.  Due to the number of 

characters being restricted, it can be customary to send short sentences using abbreviated words 

similar to operating CW.

Searching for weather information can reveal that even adjacent nearby areas can have 

dramatically differing weather patterns.  Or operating outdoors and timing transmissions to 

coincide with overhead satellite passes can result in successful satellite communications using 

only a handheld transceiver.  The opportunities for many activities exist even without installing a 

fixed station at home.

Below are two APRS operational examples.  In the U.S.A. and Canada, the national APRS 

frequency is 144.390 MHz.

6.1 Let’s Go Mobile

6.1.1 Summary

First, collect and place in your vehicle the essentials necessary for operating mobile.  You will 

need a GPS receiver, the TM-D710A/E transceiver, an antenna and miscellaneous interconnect 

cables.  As you travel, you will be looking for position beacons from nearby stations so you can 

enjoy exchanging messages and making voice contact.

The TM-D710A/E already includes functions for convenient mobile operation.  Functions like 

Frequency Display, Decay Algorithm, Proportional Pathing and SmartBeaconing are ready to use.  

Decay Algorithm automatically extends the transmission interval to reduce traffic loading when the 

speed information from GPS indicates vehicle movement is slower than 1 knot.  One knot is equal 

to 1.8 km/h, or just over 1 mile per hour.  Essentially, this indicates your vehicle is parked.  

Proportional pathing makes sure that local information is refreshed frequently, while at the same 

time minimizing network load by transmitting less often at greater distances (number of hops).  

SmartBeaconing efficiently controls the rate of beacon transmissions in relation to vehicle speed, 

direction of travel and network activity.  Still other functions exist to maximize messaging 

convenience while driving.

6.1.1.1 Automatic Reply Function

On receipt of a message, Automatic Reply automatically acknowledges the message by returning 

a preconfigured message such as: “I am QRX.  Will return at 12:35.”.  

Auto Reply is only for passing along special information to anticipated message senders when the 

operator may temporarily not be able to respond.  It should not be left on for routine operations in 

most cases because it adds unnecessary network load.  The sending station will always get an 

ACK, and this is sufficient to know that the message was delivered in most cases.

6.1.1.2 Voice Announcement Mode

Voice Announcement mode instructs the TM-D710A/E to read aloud any message text beginning 

with “%” provided the VGS-1 is installed.  The VGS-1 can speak a few common ham radio words 

but can spell any words by letter too.

6.1.1.3 Entering Characters

Characters can be entered using the DTMF keypad on the microphone as you would when texting 

from a cell phone.

Additional details of important functions follow.
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6.1.2 Decay Algorithm Function

The position beacon for a mobile station is usually transmitted at a fixed time interval to provide 

consistency in vehicle tracking and station participation.  However, when traffic is slow-moving, it 

would be inefficient use of air-time to continue transmitting at this fixed interval.  Therefore, while 

parked or moving slowly, the beacon transmission interval gradually increases by using a decay 

algorithm.  This cleverly reduces air-time used by the station without reducing the quality of station 

information being made available to the system.

Figure 6-1   Decay Algorithm

Decay Algorithm steps the transmission interval of the beacon down from 1 to 2 to 4 to 8 to 16 to 

32 minutes when the mobile station is not moving.  The speed at which Decay Algorithm decides 

that the car is parked can be set using the Stopped dropdown list in the Page 7 tab of the APRS/ 

NAVITRA window of the MCP-2A programming software.  If the mobile station’s speed is less 

than this setting, then Decay Algorithm will start.

6.1.3 Proportional Pathing Function

Proportional pathing recognizes that the value and timeliness of local information is more 

important close to the sender and of less importance farther out in the network.  To minimize 

loading on the network from distant stations, the TM-D710A/E implements Proportional Pathing to 

maintain a high update rate for local packets, but divides that rate by two at each additional hop 

through the network as shown in the diagram below.  If the transmit rate is set to 1 minute, then 

locally, the packet will be seen every minute.  But this will only be seen every 2 minutes via the 

local digipeater.  It will only be seen once every 4 minutes via surrounding two hops.  This 

algorithm drastically reduces the APRS netowrk load, while still providing good tracking to local 

mobiles.

Figure 6-2   Proportional Pathing adjusts Number of Relays (when using WIDE1-1,WIDE2-2)

To alleviate this problem, Proportional Pathing automatically changes the number of packet relay 

hops every time the beacon is transmitted.  The effect of this is that nearby stations will receive 

updates frequently while more distant stations will receive half as many updates.  The speed at 

which Proportional Pathing decides that the car is moving can be set using the Moving dropdown 

list in the Page 7 tab of the APRS/ NAVITRA window of the MCP-2A programming software.  If 

the mobile station’s speed exceeds this setting, then Proportional Pathing will start.

Traffic Jam!

Transmits the
position beacon

2 minutes1 minute 4 minutes 8 minutes 16 minutes 32 minutes 32 minutes

Transmits
every 1 minute

Transmits
every 1 minute

Transmits
every 1 minute

Transmits
every 1 minute

Transmits
every 1 minute

Transmits
every 1 minute

Transmits
every 1 minute

DIRECT
(No hop)

DIRECT
(No hop)

DIRECT
(No hop)

DIRECT
(No hop)

WIDE1-1
(1 hop)

WIDE1-1
(1 hop)

WIDE1-1,WIDE2-1
(2 hops)

WIDE1-1,WIDE2-2
(3 hops)
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6.1.4 Simultaneously using Decay Algorithm and Proportional Pathing

Refer to the diagram below to understand what occurs when both Decay Algorithm and 

Proportional Pathing are used at the same time.

Figure 6-3   Switching between Decay Algorithm and Proportional Pathing 

(when Stopped=1 (knot); Moving=3 (knots))

As the example above shows, when the mobile’s speed exceeds 3 knots, Decay Algorithm stops 

and Proportional Pathing begins.  Similarly, when the mobile’s speed drops below 1 knot, then 

Proportional Pathing stops and Decay Algorithm begins.

Note: The Stopped value cannot be configured higher than the Moving value, and the Moving value cannot be configured 
lower than the Stopped value.

6.1.5 SmartBeaconing (Written by Steve Bragg, KA9MVA)

SmartBeaconing was added beginning with operation panel firmware version 2.00 for the TM-

D710A/E and RC-D710.  SmartBeaconing was developed by Mr. Steve Bragg, KA9MVA and Mr. 

Tony Arnerich, KD7TA in 1998.  SmartBeaconing uses the traveling direction and speed 

information that is received from the GPS receiver to efficiently transmit the beacon.  There are 

two factors that come into play when determining how SmartBeaconing functions: distance 

traveled since last beacon transmission, addressed by using Variable Rate Beaconing to change 

the transmission interval with speed, and heading change since last beacon transmission, referred 

to as Corner Pegging.

6.1.5.1 Variable Rate Beaconing (Transmission Interval Changes with Speed)

When your mobile station is moving at a speed less than LOW SPEED as set in the menu, the 

position beacon repeatedly transmits at the interval of SLOW RATE as set in the menu.  When 

your mobile station is moving faster than HIGH SPEED as set in the menu, the position beacon 

repeatedly transmits at the interval of FAST RATE as set in the menu.  And if your mobile is 

traveling at any speed between LOW SPEED and HIGH SPEED, then the beacon transmits at an 

interval that varies linearly according to the speed traveled.  The transmission interval extends 

longer as the speed becomes slower, and the interval becomes shorter as the speed gets faster.

Table 6-1   Relationship between Speed and Beacon Transmission Interval

Speed Transmission Interval

Over HIGH SPEED FAST RATE

Under HIGH SPEED

Over LOW SPEED

(Only when HIGH SPEED ≥ LOW SPEED )

Calculate using the formula below:

FAST RATE x HIGH SPEED ÷ current speed = transmission 

interval time

Under LOW SPEED SLOW RATE

Now

Proportional

Pathing

Returns

to Decay

Algorithm

Velocity (Knots)

Status

0 2 2 13 335

Decay Decay DecayProportional Proportional Proportional Proportional
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Table 6-2   Configuration Example

Table 6-3   Variable Rate Beaconing Example:

(with LOW SPEED = 5, HIGH SPEED = 70, SLOW RATE = 30 min, FAST RATE = 120 sec)

Figure 6-4   Speed vs TX Interval Time

Note: The unit of Speed can be configured by using Menu 626.

Menu Item Configured Value

LOW SPEED 5

HIGH SPEED 70

SLOW RATE 30 minutes

FAST RATE 120 seconds

Speed
TX interval Time 

(FAST RATE = HIGH SPEED ÷ Speed)

80 120 seconds (2 minutes)

70 120 seconds (2 minutes)

60 140 seconds (2 minutes and 20 seconds)

50 168 seconds (2 minutes and 48 seconds)

40 210 seconds (3 minutes and 30 seconds)

30 280 seconds (4 minutes and 40 seconds)

20 420 seconds (7 minutes)

10 840 seconds (14 minutes)

5 1680 seconds (28 minutes)

0 1800 seconds (30 minutes)
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6.1.5.2 Corner Pegging (Transmission after Heading Change)

When the mobile station’s speed is above LOW SPEED, Corner Pegging begins operating. A 

Corner Pegging position beacon will be transmitted when the heading difference exceeds the 

TURN THRESHOLD value. The heading difference is the compass heading of the present 

direction of travel (in degrees) subtracted from the compass heading transmitted in the previous 

position beacon. (Technical note: only the absolute value of the heading difference, normalized to 

the first and second quadrants, is used.) The threshold value called TURN THRESHOLD 

combines a fixed angle threshold, called TURN ANGLE, with a constant called TURN SLOPE, 

times ten, divided by the present speed. You can use the formula below to calculate TURN 

THRESHOLD.

By changing the value of TURN SLOPE, you can adjust how Corner Pegging responds as the 

mobile station executes curves. When the value of TURN SLOPE is increased, a large heading 

angle change is necessary to cause a position beacon transmission, especially at low speeds. 

When the value of TURN SLOPE is reduced, the effect of speed on Corner Pegging is reduced, as 

the constant TURN ANGLE becomes the controlling term in the equation. A value for TURN 

SLOPE of 110 (in units of 10 degrees per mph) has been experimentally determined to be a good 

value for vehicles on typical roads.

Corner Pegging Formula:

TURN THRESHOLD = TURN ANGLE + 10 x TURN SLOPE / SPEED

The above formula is based on the reality of how a mobile station executes turns: when traveling 

at slow speed, it can turn acute angles, but when traveling at high speeds, it turns only shallow 

angles. In other words, TURN THRESHOLD varies inversely with speed: at a low speed, the 

threshold becomes large, while at a high speed the threshold becomes small.

To prevent the Corner Pegging beacon from transmitting too often and causing QRM, there is a 

timer value called TURN TIME. The Corner Pegging position beacon is not transmitted until TURN 

TIME seconds have elapsed since the previous beacon transmission, regardless of which method 

(Corner Pegging or Variable Rate Beaconing) caused the previous beacon.

Table 6-4   Conditions for Corner Pegging Operation

Table 6-5   Configuration Example

Speed Corner Pegging

Over HIGH SPEED Yes

Under HIGH SPEED

Over LOW SPEED

(Only when HIGH SPEED ≥ LOW 

SPEED)

Yes

Under LOW SPEED No

Menu Item Configured Value

LOW SPEED 5

TURN ANGLE 28 degrees

TURN SLOPE 26 (x10 deg/speed)

TURN TIME 30 seconds
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Table 6-6   Corner Pegging Operation Example: 

(with TURN ANGLE = 28, TURN SLOPE = 26)

Note: When TURN THRESHOLD exceeds 120 degrees, the value will be corrected to 120 degrees.

Figure 6-5   Speed vs Turn Threshold

6.1.5.3 Operation Example

Here are the TM-D710A/E default settings for position beacon transmissions using the 

SmartBeaconing configuration as shown below.

Table 6-7   SmartBeaconing Configuration Values

Note: If SmartBeaconing does not result in appropriate beacon transmissions, then you must re-configure individual 
parameters so as to more closely match driving conditions.

Speed TURN SLOPE
TURN SLOPE ÷ Speed 

(Cut off after the decimal point) (1)
TURN ANGLE (2)

TURN THRESHOLD

(3) = (1) + (2)

80 26 (x10) 3° 28° 31°

70 26 (x10) 3° 28° 31°

60 26 (x10) 4° 28° 32°

50 26 (x10) 5° 28° 33°

40 26 (x10) 6° 28° 34°

30 26 (x10) 8° 28° 36°

20 26 (x10) 13° 28° 41°

10 26 (x10) 26° 28° 54°

5 26 (x10) 52° 28° 80°

2 26 (x10) 130° 28° 158°  120°

Menu Item Configured Value

LOW SPEED 5

HIGH SPEED 70

SLOW RATE 30 minutes

FAST RATE 120 seconds

TURN ANGLE 28 degrees

TURN SLOPE 26 (x10 deg/speed)

TURN TIME 30 seconds
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6.1.6 QSY Function

The QSY function uses AFRS (Automatic Frequency Reporting System) to report a frequency on 

which voice communications can be established.  A station using the QSY function embeds the 

frequency information in a position beacon transmission.  A receiving station of this information 

can change frequency, or QSY, over to the reported voice frequency to begin voice 

communication by the press of [TUNE] on the TM-D710A/E.

6.1.6.1 Transmitting QSY Information

A properly configured functioning TM-D710A/E QSY station can automatically embed the voice 

frequency from the non-data band to the beginning of status text.  In Status 5, “[Freq MHz]” is 

entered.  This is the mechanism used for automatically transmitting the frequency information.  

The format of the transmitted frequency is FFF.FFF MHz.

So, for example, if at the time of a beacon transmission, the non-data band has a frequency of 

446.100 MHz selected, then the frequency of “446.100MHz” gets embedded to the beginning of 

the status text.  If you configure in any of Statuses 1 through 4 the frequency of “446.100MHz” at 

the beginning of the status text messages, then this fixed frequency will be transmitted as QSY 

information along with the beacon transmission.  In addition to frequencies, there are fields where 

you can send other settings such as Wide/Narrow, Tone/CTCSS/DCS, Shift (+/-), and Offset 

frequency simply by leaving one space between each value.  Therefore, other information besides 

just a frequency can be sent.

QSY Information Format:

(Insert one space after the frequency before entering Wide/Narrow, Tone/CTCSS/DCS and 

Shift/Offset.)

� “T079”: An upper case “T” indicates Wide.  Tone frequency of 79.7 Hz. (Encoding)

� “t079”: A lower case “t” indicates Narrow.  Tone frequency of 79.7 Hz. (Encoding)

� “tOFF”: A lower case “t” indicates Narrow.  Tone = OFF (Without any tone Encoding or Decoding.)

� “C079”: An upper case “C” indicates Wide.  CTCSS frequency of 79.7 Hz. (Encoding/ 

Decoding)

� “c079”: A lower case “c” indicates Narrow.  CTCSS frequency of 79.7 Hz. (Encoding/ Decoding)

� “D023”: An upper case “D” indicates Wide.  DCS code of 023. (Encoding/ Decoding)

� “d023”: A lower case “d” indicates Narrow.  DCS  code of 023. (Encoding/ Decoding)

� “+” : Plus Shift (A default offset frequency is applied.)

� “-” : Minus Shift (A default offset frequency is applied.)

� “+500” : Plus Shift, 5MHz Offset (“+5000kHz” is also available)

� “-060”: Minus Shift, 600kHz Offset (“-0600kHz” is also available)

The value of the Offset shall be a 3-digit numeric. (x 10kHz/ 50kHz step)

Note: For detailed information on the QSY Function format, refer to the following link (http://www.ew.usna.edu/~bruninga/
aprs/freqspec.txt).  The TM-D710A/E transceiver complies with the standard which was proposed by Bob Bruninga, 
WB4APR.

http://www.ew.usna.edu/~bruninga/aprs/freqspec.txt
http://www.ew.usna.edu/~bruninga/aprs/freqspec.txt
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Configuration Examples:

(Insert one space after the frequency before entering Wide/Narrow, Tone/CTCSS/DCS and Shift/

Offset.)

� “446.100MHz”: Voice frequency configured for 446.100 MHz, Wide, Tone = None, Simplex

� “446.100MHz T071”: Voice frequency configured for 446.100 MHz, Wide, Tone of 71.9 Hz, 

Simplex

� “446.100MHz t071”: Voice frequency configured for 446.100 MHz, Narrow, Tone of 71.9 Hz, 

Simplex

� “446.100MHz C100” : Voice frequency configured for 446.100 MHz, Wide, CTCSS of 100 Hz, 

Simplex

� “446.100MHz c100”: Voice frequency configured for 446.100 MHz, Narrow, CTCSS of 100 Hz, 

Simplex

� “446.100MHz D023”: Voice frequency configured for 446.100 MHz, Wide, DCS 023, Simplex

� “446.100MHz d023”: Voice frequency configured for 446.100 MHz, Narrow, DCS 023. Simplex

� “446.100MHz tOFF”: Voice frequency configured for 446.100 MHz, Narrow, Tone = None, 

Simplex

� “146.850MHz” : Voice frequency configured for 146.850 MHz, Wide, Tone = None, Minus Shift, 

600kHz Offset (TM-D710A’s Auto Repeater Offset may work)

� “444.750MHz TOFF +”: Voice frequency configured for 444.750 MHz, Wide, Tone = None, + 

Shift, Offset = default on UHF band (5MHz)

� “146.850MHz T131 -060”: Voice frequency configured for 146.850 MHz, Wide, Tone = 

131.8Hz, - Shift, 600kHz offset

� “146.850MHz T131 -0600kHz”: Voice frequency configured for 146.850 MHz, Wide, Tone = 

131.8Hz, - Shift, 600kHz offset,

“-0600kHz”, 600kHz offset: The last digit “0kHz” is ignored by the TM-D710A it’s just for easier 

understanding for operators.

� “444.7625MHz tOFF +”: Voice frequency configured for 444.7625 MHz, Narrow, Tone = None, 

+Shift, Offset = 5 MHz (Default value on UHF band)

� “444.7625MHz t131 +4MHz”: Voice frequency configured for 444.7625 MHz, Narrow, Tone = 

131.8Hz, +Shift, Offset = 5 MHz (Default offset on UHF band), “4MHz” is not allowed and it 

results in a syntax error for TM-D710A so that the default offset 5 MHz (K-type) is applied 

instead.

Figure 6-6   Status Text 5 

Figure 6-7   Status Text 2 Input Example
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6.1.6.2 Receiving QSY Information

The TM-D710A/E receives QSY information not only from another TM-D710A/E, but also location 

information from other software as well as QSY information and repeater frequency object 

information embedded in status text.  You can confirm the QSY information that is received as 

embedded data by checking the voice frequency at the beginning of the status text on the Station 

List screen.

To immediately select the frequency, press [DETAIL], switch on the List Detail screen and press 

[TUNE].  The transceiver will change quickly to the non-data band frequency.  Also, on the Station 

List screen, information that already is embedded in the QSY information will appear on the right 

side of the screen and can be easily confirmed.  You can quickly switch over to the non-data band 

frequency by pressing [TUNE].

Wide/Narrow, Tone/CTCSS/DCS and Shift/Offset configuration information can be received as 

status text with firmware version 2.0 or later.  Pressing [TUNE] allows you to modify the voice 

frequency, and also to configure Wide/Narrow, Tone/CTCSS/DCS and Shift/Offset.

Figure 6-8   QSY Station List Screen

6.1.6.3 QSY Functions and EchoLink

EchoLink system operators can configure their nodes to generate APRS objects that contain their 

QSY Frequency information.  These beacons can either be transmitted locally on the APRS 

channel, or generated directly to the APRS-IS for dissemination back to RF via the local IGate 

station.  It is important for nearby travelling mobiles to see these QSY Frequency objects on their 

maps and the front panel of their TM-D710A/E transceivers when traveling in new areas.

6.1.7 Message Function

The Message function closely resembles other amateur radio modes since it consists of 

exchanging messages with hams.  You can send a message by entering a callsign of the 

message recipient.  You’ll receive an acknowledgement (ACK) message back when the targeted 

station receives the message.  You can also enjoy group messaging by using a group name 

instead of a callsign.  A group name can be configured via Menu 623.  In addition, there is a 

bulletin function.  Using bulletins, you can report on upcoming events or other information to a 

large collection of users over a broad region.
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6.1.7.1 Automatic Reply Message

The Automatic Reply Message function replies to messages that you receive while you are 

driving.  You can pre-configure a message response such as “I am QRX.  Will return at 12:35.”.  

When using TH-D7A/E or TM-D700A/E, a response message was returned to all message 

senders.  But, beginning with TM-D710A/E, an individual can be selected to receive a reply.

You can configure callsigns to which you want to reply.  When the “*” wildcard is used, the 

transceiver will respond to all message senders.  But if you set “W6DJY”, the transceiver will reply 

only to W6DJY.  Configuring “W6*” will trigger a reply only to senders with W6 as their callsign 

prefix.

Figure 6-9   Automatic Reply Message Configuration Screen

6.1.7.2 Message Speech Synthesis

While in Voice Announcement mode, any message text beginning with “%” will be read aloud 

including callsigns provided the VGS-1 is installed and configured.  Menu 624 (APRS VOICE) 

must be configured On.

Example:

%I am QRX.  Will return at 12:35.

The callsign and message will be read out loud letter by letter (not word by word) when a message 

like this is received.

Figure 6-10   Voice Announcement Mode

6.1.7.3 TX Beep (Beacon)

Select Menu 624 (SOUND - TX BEEP (BEACON)) and select “ON” to sound a beep everytime the 

TM-D710A/E transmits a beacon.  It is convenient for monitoring the beacon transmissions when 

SmartBeaconing or Decay Algorithm is used.  If “OFF” is selected, the transceiver does not beep 

even if a beacon is transmitted.
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6.2 Base Station (Weather Station)

Weather observation equipment intended for use at home is becoming more common.  Using this 

equipment, you can observe and measure wind direction, wind velocity, air temperature, humidity, 

rainfall, atmospheric pressure, etc.  This information can be useful to others when the data is 

gathered and transmitted in real time via APRS beacon transmissions.  

These kinds of weather stations are installed in many parts of the world.  Some stations transmit 

NWS (National Weather Service) information that is dispatched and converted for beacon use.  

Local important information, such as locations of nearby tornados as they are forming, which has 

not been registered with central weather bureaus can be transmitted by APRS beacon.

Weather observation equipment can be connected to a TM-D710A/E or RC-D710 in place of a 

GPS receiver via the GPS connector.  The weather observation equipment transfers the 

meteorological information with serial data and this data is transmitted via beacon transmissions 

using the APRS weather format.  Or you can monitor the meteorological data locally on the screen 

of the TM-D710A/E or RC-D710.  The TM-D710A/E and RC-D710 can display six different 

meteorological measurements: rainfall, air temperature, wind direction, wind velocity, atmospheric 

pressure and humidity.

6.2.1 Using Meteorological Equipment

Select Menu 602 (APRS - GPS PORT) and configure the GPS terminal settings.

� Baud Rate: 9600 bps (same as weather equipment being used)

� Input: WEATHER (Davis) or WEATHER (Peet Bros.)

� Output: OFF

Figure 6-11   Menu 602 (GPS PORT) used with Weather Equipment

Equipment that has been verified with our transceiver includes the following models.

6.2.1.1 Davis Instruments Corp.

The weather station, Vantage Pro2 from Davis Instruments (http://davisnet.com/weather/products/

vantage2.asp) can be used with TM-D710A/E or RC-D710.

“WeatherLink for Vantage Pro2, Windows, Serial Port” (Davis Part #.06510SER) or “WeatherLink 

for APRS with Streaming Data Logger” (Davis Part #.06540) is required for TM-D710A/E and 

RC-D710.  Install the adaptor that comes with the above accessories to work with TM-D710A/E or 

RC-D710.

To communicate with Vantage Pro2, configure the communication baud rate of Vantage Pro2 for 

9600 bps using the panel keys and then configure the TM-D710A/E communication baud rate 

(Menu 602) to 9600 bps as well.

Note: 4800 bps (06540/ 06510SER) or 2400 bps (06510SER) may work with TM-D710A/E but we recommend using 9600 
bps for stable operation.

http://davisnet.com/weather/products/vantage2.asp
http://davisnet.com/weather/products/vantage2.asp
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6.2.1.2 Peet Bros. Company, Inc.

The weather station, ULTIMETER 2100 from Peet Bros. Company (http://www.peetbros.com/

shop/item.aspx?itemid=2) can also be used with TM-D710A/E or RC-D710. 

To communicate with ULTIMETER 2100, configure the TM-D710A/E communication baud rate 

(Menu 602) to 2400 bps.

Note:

Because the GPS receiver and the weather observation equipment use the same connector, combined use is not 

possible.

5 to 10 minutes after powering up the transceiver, you will begin to acquire meteorological data from the weather 

observation equipment.

Meteorological data that is received from other stations is displayed in the Station List details on 

the second page.  As shown below, the information is easy to understand.

Figure 6-12   Meteorological Data Display

http://www.peetbros.com/shop/item.aspx?itemid=2
http://www.peetbros.com/shop/item.aspx?itemid=2
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7  APRS NETWORKS

7.1 Servers

In the beginning, APRS networks consisted only of general packet transmissions through digital 

repeaters.  To expand network coverage much further, HF gateway stations that were interfaced 

with the VHF stations were added.  This arrangement evolved still further when it became 

common for personal computers to be connected with the Internet.  Internet gateways provided 

another way to expand APRS coverage.  APRServe, developed by Mr. Steve Dimse, K4HG, 

allows information that is gathered from the Internet to be transferred to client computers.  The 

worldwide APRS network was completed.  The service is called APRS IS (APRS Internet Service).

At present, there are several basic servers that are called Core servers.  Approximately 40 local 

servers, called Tier 2 servers, are located worldwide in each participating country and work under 

the Core servers.  Later, Pete Loveall, AE5PL developed javAPRSSrvr to establish a Tier-2 

distribution system to better handle regional APRS-IS feeds.  The Internet part of the APRS 

system is called APRS-IS (APRS-Internet Service).

7.2 IGate

There are basically two ways to use APRS-IS effectively when operating APRS: a client personal 

computer connected directly to Core/ Tier 2 servers, and using amateur radio with IGate (Internet 

gateway).

For client use, a callsign is required, but amateur radio equipment is not necessary.  You simply 

install APRS software on a personal computer, configure the necessary station information and 

connect to an APRS server via the Internet.  With this arrangement, you can enjoy the basic 

features of APRS such as transmitting your own station position, exchanging messages and 

dispatch or receipt of weather information.

Using TM-D710A/E or RC-D710, you can transmit your own packet signals via amateur radio and 

use APRS-IS to access IGate.  IGate acts as a two-way interface between the Internet and 

amateur radio packet signals.  The IGate function is obtained through various releases of APRS 

software and IGate is commonly available as a result of many volunteer amateur radio operators.  

IGate connects directly to Core servers and Tier 2 servers.  Information received by amateur radio 

packet transmissions is transferred to the servers, and server information can be passed via 

packet radio transmissions back to amateur radio operators.

New IGate stations in areas where IGate access is already available are added as necessary as 

traffic warrants.  Traffic from IGate to amateur radio stations increases air traffic which can 

undesirably overload frequencies.  Therefore, you must be familiar with operational configurations.  

Various filtering functions exist so you should be knowledgeable about your local existing IGate 

station.  It is best to minimize traffic as much as possible.  In the case of packet messaging, 

bidirectional data transfers are used.

To use TM-D710A/E or RC-D710 efficiently at a fixed station includes configuring the callsign and 

the packet path to your local IGate station.  In cases of mobile stations, you can similarly initially 

configure the packet path, but it is good to follow local rules of each new area where you may 

operate.
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Figure 7-1   APRS Network Conceptual Drawing
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7.3 Let’s Send Email

With TM-D710A/E and RC-D710 it is possible to transmit email by using the Message function.

7.3.1 Sending Email with TM-D710A/E and RC-D710

First, press [MSG] to show the Message List on the screen.  Next, press [NEW] to create a 

message on the screen.  Enter “EMAIL” to TO: field using the Tuning Control on the panel or the 

numeric keypad on the microphone.

Figure 7-2   Using Email Function

Next, enter the email address to which you wish to send email.  Leave one space blank after the 

address and begin entering the message text.  See an example below.

Figure 7-3   Entering Email Address and Message

The message can be entered using the Tuning Control on the panel or the numeric keypad on 

the microphone.  When the message is completely entered, it will be transmitted in an APRS 

message.  Email is transmitted via the IGate and the APRS server is connected to the Internet.

Figure 7-4   Transmission Flow for Email

Note: You cannot send email from a personal computer to a mobile station.
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7.4 Digipeaters (Digital Repeaters)

The greatest feature of APRS is the network that is spreading around the world.  The heart of the 

network is made up of many digital repeaters commonly referred to as digipeaters.  Of course, 

digipeaters are well-known among those who have used packet radio for years.  Digipeaters 

receive data over-the-air via radio signal and repeat or relay it onward.  For a voice repeater, two 

different frequencies are used simultaneously to accomplish this repeater function.  However, a 

digipeater first receives and stores data, and then transmits when the channel clears.

In the earlier times of packet radio and digipeaters, it was required to specify the callsign of each 

digipeater station.  But it was difficult to know which digipeater station to use.  If moving in a 

vehicle, you had to constantly consider changing digipeaters.  Now, APRS uses a common 

generic callsign for all digipeaters referred to as WIDEn-N, where N is the number of hops desired 

through the network (typically 2).  The WIDE terminology lets you know the digipeater is in a good 

location for repeating signals.  A mobile station anywhere only has to specify WIDE1-1 without 

needing to know a specific callsign of a digipeater in order to digipeat their beacon transmission.

APRS evolved over many years beginning in 1992, and there were many inefficient older network 

concepts that were still being used in some areas.  You still may see references to these obsolete 

techniques (RELAY, WIDE, TRACE, and TRACEn-N).  By 2004, it was decided it was time to 

abandon those many older inefficient paths and concentrate on only the fully traceable WIDEn-N 

algorithm.  This universal upgrade of the APRS network to just the one simple and traceable 

WIDEn-N concept was called the New-N Paradigm.  Since its adoption, most areas have seen 

many improvements in local area APRS reliability.  In most areas of the country, the number of 

hops should be no more than WIDE2-2 because additional hops just add too much network load 

and too much interference from stations far away.

The following sections explain configuration of the TM-D710A/E for use with digipeaters.

7.4.1 UIDIGI

With UIDIGI activated (On), when a digipeater receives a UI frame with a character string for alias 

(such as RELAY, WIDE1-1, etc.) that matches the alias character string in the digipeater, the 

digipeater repeats the packet substituting the callsign from the digipeater’s MY CALLSIGN 

configuration and adding a completed flag (*).

UIDIGI should normally be off in a mobile.  It is not good for mobiles to be digipeating all packets 

on the channel because it causes much interference.  But sometimes, in special cases, when a 

mobile is being used on top of a hill or a special weak area to provide temporary emergency 

digipeating, then UIDIGI can be enabled with the WIDE1-1 alias so that this mobile can serve as 

the first hop out of an area.  WIDE1-1 digipeating only operates on the first hop, so there is not 

much damage to the network or to other traffic

Figure 7-5   Using UIDIGI

MYCALL: N6NRR

UIDIGI: ON

ALIASES: WIDE1-1

WB4APR-9 > APK102, 

WIDE1-1, WIDE2-1: Test

WB4APR-9 > APK102, 

N6NRR*, WIDE2-1: Test
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7.4.2 UIFLOOD

With UIFLOOD activated (On), when a digipeater receives a UI frame with a character string for 

alias in the form XXXXn-N where XXXX matches the alias character string in the digipeater, the 

digipeater subtracts 1 from N and processes the packet reporting only the revised character string 

so as not to make the frame length too long.  The UIFLOOD technique does not provide traceable 

paths, so its use is not recommended except for supporting the SSn-N or SSSn-N state or regional 

paths.  Also the example should change to start with SS3-3 instead of WIDE3-3.  UIFLOOD 

should very rarely be used by mobiles.  

Figure 7-6   Using UIFLOOD

The UIFLOOD method of digipeating is only a function of a full sized properly configured 

permanent digipeater.  If a mobile is activated with UIFLOOD, it can cause much unnecessary 

interference to the network.  The only time to ever activate a mobile with UIFLOOD is in very 

special cases, when a mobile is being used on top of a hill to provide temporary emergency 

digipeating to replace a broken or missing wide area digipeater.

7.4.3 UITRACE

UITRACE functions similar to UIFLOOD with the difference that UITRACE reports the full relay 

path of digipeaters that were used to relay the message.  UITRACE is the most powerful and 

traceable digipeating function in APRS.  It is the basis of the New-N paradigm discussed in 7.4 

Digipeaters.  Therefore, with UITRACE activated (On), when a digipeater receives a UI frame with 

a character string for alias in the form XXXXn-N where XXXX matches the alias character string in 

the digipeater, the digipeater subtracts 1 from N and processes the packet reporting each of the 

previous digipeaters as well as itself resulting in a frame length that becomes longer as the 

message is relayed.  Using UITRACE allows you to confirm the exact routing of any message.

Like UIDIGI and UIFLOOD, UITRACE should normally never be enabled by a mobile except in 

very unusual circumstances.

Figure 7-7   Using UITRACE

MYCALL: W4DJY

UIFLOOD: ON

ALIAS: MD

SUBSTITUTION: ID

WB4APR-9 > APK102,

MD3-3: Test

WB4APR-9 > APK102,

W4DJY*, MD3-2: Test

MYCALL: W5DJY

UIFLOOD: ON

ALIAS: MD

SUBSTITUTION: ID

WB4APR-9 > APK102,

W5DJY*, MD3-1: Test

"MD" stands for 

Maryland.

MYCALL: W4DJY

UITRACE: ON

ALIAS: WIDE

WB4APR-9 > APK102,

WIDE3-3: Test

WB4APR-9 > APK102,

W4DJY*, WIDE3-2: Test

MYCALL: W5DJY

UITRACE: ON

ALIAS: WIDE

WB4APR-9 > APK102,

W4DJY, W5DJY*,

WIDE3-1: Test
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Although UITRACE using the normal APRS network path of WIDEn-N can be a problem if mobiles 

activate their digipeater at the wrong time, it is also so powerful, that it is a shame not to be able to 

use it easily if required.  For this reason, all APRS mobiles are encouraged to activate the 

UITRACE permanently, BUT using the alias of TEMP instead of WIDE.  This makes the mobile 

always possible to use as a TEMPn-N digipeater while avoiding the problem of adding 

interference to the normal use of WIDEn-N.

Figure 7-8   

7.4.4 Configuration Examples (U.S.A.)

Two configuration examples are shown below.

Example 1:

This example shows configuration for a typical TM-D710A/E mobile installation for general use in 

routine operation.

UIDIGI

UIDIGI: OFF

ALIAS: WIDE1-1

(This allows this mobile to become a first-hop digipeater by simply configuring UIDIGI to On.)

UIFLOOD

UIFLOOD: OFF

ALIAS: NONE

SUBSTITUTION: ID

(This is not used.  If this mobile is needed as a temporary digipeater, then this field can be used in 

support of SSn-N.  But if WIDEn-N temporary support is needed, then the UITRACE command 

can be used.)

UITRACE

UITRACE: ON

ALIAS: TEMP

(This allows TM-D700A/E, TM-D710A/E or RC-D710 to always be a temporary digipeater at any 

time and anywhere in support of the TEMPn-N path.)

Example 2:

This is a general recommendation for permanent digipeaters installed at a high location.

W4DJY W5DJY

WB4APR-9 > APK102,

TEMP1-1, WIDE2-2: Test

All mobiles can act as

TEMPn-N digis all the time

if needed for emergency

WB4APR-9 > APK102,

TEMP1*, WIDE2-2: Test

WB4APR-9 > APK102,

TEMP1, W4DJY*,

WIDE2-1: Test

WB4APR-9 > APK102,

TEMP1, W4DJY, W5DJY*,

WIDE2: Test

Not

working
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UIDIGI

UIDIGI: ON

ALIAS: SAR 

(other local paths can be defined here)

Note: SAR stands for “Search and Rescue”.

UIFLOOD

UIFLOOD: ON

ALIAS: SS or SSS

SUBSTITUTION: ID

(where SS or SSS is the abbreviation of state or ARRL section)

UITRACE

UITRACE: ON

ALIAS: WIDE

7.4.5 Proper Configuration (written by Bob Bruninga, WB4APR)

New-N Paradigm recommends three major routing paths.  The most important is the National 

Standard of WIDEn-N (usually 2-2).  It should always be used for routine operations.  However 

there are two other possible network arrangements for special situations: SSn-N and TEMPn-N.

SSn-N is for state or ARRL section communication special nets.  These nets are called up for drills 

or for emergencies.  During these periods, it is desirable to have all APRS participants over the 

state or section area to be able to communicate among each other.  In some states, this may take 

more than a 2-hop path.  But using more than 2 hops also causes many packets to go outside of 

the state and to add QRM in adjacent areas which is poor operating practice.

To allow longer hops within the state or section for these events, the SSn-N routing mechanism 

can be used.  For example, using WIDE3-3 from the middle of Maryland would reach all 

digipeaters in Maryland, but someone in the far west or far southeast would need 5 hops.  But 

such a 5-hop path would cause QRM over 13 states!  However, by using the state routing path of 

MD5-5, the sender’s packets will go a full 5 hops in Maryland, but will not go into any adjoining 

states.  In fact, for the user in the center that only needs 3 hops, it does not make any difference to 

use MD5-5 or MD3-3, because in either case, his packets will hit all the digipeaters in Maryland.  

So for state-wide drills, the recommended path is MD5-5 for all participants anywhere in the state.

The TEMPn-N system is an emergency backup system that is inherent in all TM-D700A/E and 

TM-D710A/E mobile transceivers.  These transceivers can all be used as backup emergency 

digipeaters in support of special needs.  All mobiles should be programmed to act as digipeaters 

for TEMPn-N packets.  In this way, these mobiles are always ready and enabled to act as 

digipeaters for this special path but, on the other hand, they do not digipeat any other packets so 

they do not add any QRM to normal operations (using WIDEn-N or SSn-N).  But at any time, 

someone in a valley, or after digipeaters are lost in an emergency, the path of TEMPn-N might be 

able to get out by hopping mobile to mobile.

To further benefit this alternate backup digipeating technique, some special battery-powered 

backup digipeaters at high locations can also support this path.
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7.5 Packet Path

It is necessary to confront the issue of frequency congestion due to the spread of APRS systems 

in order to efficiently transfer packet data.  The TM-D710A/E supports the configurations of New-N 

Paradigm, RELAY Paradigm and STATE/SECTION/REGION.  Overall, this provides an efficient 

mechanism for transferring packets.

7.5.1 New-N Paradigm

Appropriate configuration is required in order to digipeat a packet path (relay route).  New-N 

Paradigm using WIDEn-N assigns an alias and a relay stage number for digipeaters.  This system 

is mainly used by digipeaters in North America.  Japan is also using this system and it is spreading 

worldwide.  

For example, when you desire three hops, then you can configure TOTAL HOPS: 3.  Once 

configured, you can verify by using PATH IS VIA WIDE3-3.  Until recently, when a regional 

digipeater was wanted, RELAY was used but this is being replaced by WIDE1-1 simply by 

configuring On via menu selection.  Again, you can verify that WIDE1-1 or WIDE2-2 was used by 

using PATH IS VIA.

7.5.2 RELAY Paradigm

This is one of the digipeat types used in Europe. The old backwards compatible RELAY technique 

was included for some areas that have still not updated to the universal New-N Paradigm using 

traceable WIDEn-N.  It allows the first hop to be via the RELAY path and then uses TRACEn-N for 

subsequent hops.  Most of the USA is using the New-N Paradigm.  But Europe has not yet fully 

coalesced into a single common system as of this writing.

7.5.3 STATE/ SECTION/ REGION

In contrast to WIDEn-N which generates packets equally in all directions, you can use STATE/

SECTION/REGION to restrict packets to only be relayed within the specified boundary.  

Abbreviations, such as two letter AZ for Arizona or three or four letter abbreviations such as NCA 

for Northern California, are used to specify the boundary.

Using these limited regions, it is possible for stations to set up special nets under special 

circumstances to communicate over large distances without adding interference to other areas not 

involved.  For example, using WIDE5-5 from the middle of Maryland would generate hundreds of 

packets of interference in 13 surrounding states!  This is why nothing larger than WIDE2-2 is 

recommended.  However, using MD5-5 from anywhere within the state of Maryland will get from 

any corner to every other corner of Maryland (maybe 13 digipeaters total and with no duplications)  

Thus a special Maryland APRS net in support of disaster training can be held without bothering 

surrounding states.
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7.6 Using APRS and EchoLink Simultaneously

Both EchoLink Sysop mode and APRS/Packet mode using the internal TNC can be used at the 

same time.  This means that a single TM-D710A/E transceiver can serve as an EchoLink node 

station and APRS/Packet station to transmit beacons or work as a digipeater simultaneously.

To operate in EchoLink Sysop mode and use the APRS/Packet station with a single TM-D710A/E 

transceiver, assign a different band for the external data band (Menu 517) for EchoLink and the 

internal data band for Packet (Menu 529) or for APRS (Menu 601).  For example, if B-band is 

assigned for EchoLink, assign A-band for APRS/Packet mode.  Since TM-D710A/E cannot 

transmit on 2 frequencies at the same time, the transceiver transmits on the band on which a 

transmission request comes first.  If you wish to communicate between the internal TNC and a PC 

for Packet mode operation, you will need another PG-5H programming cable kit in addition to the 

PG-5H cable kit that is used for EchoLink Sysop mode.

Figure 7-9   Using APRS and EchoLink

7.6.1 Transmitting Node Information

Configure the EchoLink frequency in the transmit data for the QSY function.  Configure the APRS 

icon for EchoLink.  Since data is transmitted using APRS with a beacon transmission, this will 

send the EchoLink information.

Internet

PG-5H Cable Kit

PG-5G

To PC audio terminal

Pink:  To microphone input terminal
Green:  To line out terminal

To PC 9-pin D-SUB terminal 

To PC 9-pin D-SUB terminal 
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8  EchoLink

8.1 What is EchoLink?

EchoLink is a system that links amateur radio stations together using the Internet and allows 

amateur radio operators to enjoy speech communication with other operators via this worldwide 

network.

Figure 8-1   EchoLink System Architecture

There are many access points for EchoLink (called EchoLink nodes), such as repeater stations 

and link stations that connect to the Internet.  

Using DTMF codes transmitted from a transceiver to access a nearby EchoLink node, it is 

possible to communicate with amateur radio stations located at many places in the world.  Also, by 

using the EchoLink software without using any transceiver at all, you can have QSOs directly from 

a personal computer.  This is a major feature of EchoLink.

In order to operate an EchoLink node (link station or repeater station) or to make QSOs directly 

from a personal computer, register at the official EchoLink site and then download the software.  

You must have a valid callsign to be able to complete the registration process.  Refer to the 

EchoLink site for details on how to validate your callsign.  After being validated, you can connect to 

the EchoLink system by using the downloaded software.  Furthermore, like the Mobile User and 

the Portable User shown in Figure 8-1, software and validation is not necessary when you access 

EchoLink nodes from amateur radio equipment.

The EchoLink system is offered free of charge to the amateur radio community, and is supported 

by a network of volunteers. 

For operation details and information about EchoLink nodes, visit the official EchoLink site at 

http://www.echolink.org.  

In addition, there is much information on the Internet pertaining to EchoLink besides the official 

site where you can find useful operating tips.

Mobile User

Mobile User

Link Station

(Simplex)
Repeater Station

(Semi-Duplex)

PC User

Portable

User
Portable

User

Portable

User

Internet

EchoLink Server

http://www.echolink.org
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8.2 EchoLink and the TM-D710A/E 
(written by Jonathan Taylor, K1RFD)

The Kenwood TM-D710A/E (and TM-V71A/E) is the first commercially-available amateur radio 

transceiver with built-in EchoLink system capabilities.  There are two different features of the 

TM-D710A/E that make it useful for EchoLink operation:

� The rig supports EchoLink “node memories”, for use when mobile.  You can store the node 

number of your favorite EchoLink nodes in the transceiver’s memory.  When you are in range of 

a local EchoLink node, you can use a short-cut command to have the rig send the correct 

DTMF sequence to connect the local EchoLink node to a distant EchoLink node. 

� The rig makes it easier to set up your own EchoLink node by including a built-in PC interface.  

If you purchase the optional PC cable kit, you can connect the transceiver directly to the sound 

card and serial port of your PC to have it operate as an EchoLink node. 

8.2.1 Sysop Mode

With the optional PG-5H cable kit, the TM-D710A/E can be connected directly to a PC to run the 

EchoLink software in Sysop mode.  In Sysop mode, EchoLink forms a gateway between the 

Internet and a local RF channel, such as a simplex frequency or a nearby repeater.  This allows 

other nodes on the EchoLink system to communicate with mobile or portable users in your area.  

Other EchoLink users can connect to your node, or local mobile and portable users can use the 

DTMF pad on their rigs to connect your EchoLink node to other nodes on the system.  For details, 

refer to 8.5 Setting Up a Node Station (Link Station) with TM-D710A/E.

The TM-D710A/E connects to the sound card and serial port of your PC.  The sound card 

connection handles the transmitted and received audio, and the serial-port connection takes care 

of PTT control and carrier detect.  This allows the EchoLink software to key and un-key the 

TM-D710A/E’s transmitter, and to detect the presence of a signal received by the TM-D710A/E.

8.2.2 Making the Connections

The Kenwood PG-5H is a package of two different cables.  Following the instructions in the 

TM-D710A/E Instruction Manual, connect the cables to the two jacks in the back of the transceiver 

and to the serial port and sound card jacks of your computer. The pink plug goes to the 

microphone input of the sound card, and the green plug goes to the sound card’s line out 

(or speaker out).  The black 9-pin connector goes to the computer’s serial port.

Many modern computers have USB ports, but no serial ports.  If your computer has no serial port, 

you will need to use either a serial-to-USB adapter cable, or a serial port option card.  Either can 

be purchased from stores that sell computer accessories.

8.2.3 Transceiver Set-Up

You will need to put the transceiver into EchoLink Sysop mode.  To set up the transceiver, hold 

down [PF2] while pressing the power button. Set up the link frequency on the "data band" 

(normally the left-hand side of the transceiver) and be sure it is enabled for "PTT" and "CTRL".
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8.2.4 Audio Adjustment

Proper adjustment of the audio levels is important for a good-quality link.  You will need to adjust 

both the local transmit audio (from the computer to the transceiver), and the local receive audio 

(from the transceiver to the computer).

First, connect EchoLink to the Audio Test Server, by choosing Connect to Test Server from the 

Station menu.  Then, choose Adjust Sound Device -> Recording from the Tools menu.  Tune the 

TM-D710A/E to a local signal, or generate an on-air signal yourself using another rig.  Watch the 

audio level meter at the bottom center of the EchoLink screen, and adjust the computer’s 

Microphone level until audio peaks just begin to go into the red area.

You might find that you are unable to get enough audio level even with the Microphone level set to 

maximum.  If that’s the case, the audio output level from TM-D710A/E can be adjusted using the 

MCP-2A software, downloadable from the Kenwood Support Web site.  Once you have the 

MCP-2A program up and running, go to the Data Terminal Adjustment section, and increase the 

PR1 Output Level (EchoLink Mode) from 3 to a higher value such as 6 or 7.  After writing the new 

setting back to the transceiver, check and adjust the input (Recording) microphone level as before.

The next step is to adjust the audio from the PC to the rig.  Adjust the Playback level so that your 

node’s locally-transmitted audio sounds clean.  Disconnect from the Test server, then choose 

Tone Generator from EchoLink’s Tools menu to produce a zero-level tone into the TM-D710A/E.  

Choose Adjust Sound Device -> Playback from the Tools menu.  While listening on a nearby 

receiver, adjust the Playback (Wave) level so that the tone sounds full but not distorted.

8.2.5 COS versus VOX

If you are running your node as a simplex link, the settings on the RX Ctrl tab (described above) 

should be fine; EchoLink will detect an incoming signal whenever the transceiver’s squelch opens.  

However, if the transceiver is tuned to the frequency pair of a local repeater, you might get better 

results by using EchoLink’s VOX for carrier detect.  When properly adjusted, this will avoid the 

extra delay imposed by the “tail” at the end of each of the repeater’s transmissions.  You may also 

want to enable EchoLink’s Squelch Crash Anti-Trip feature to prevent incidental sounds such as 

courtesy tones from tripping the VOX.  (See the EchoLink Help file for details on this feature).

An even better solution is to configure the repeater itself so that it transmits a sub-audible 

(CTCSS) tone only during the time that a signal is being received on its input.  With this 

arrangement, you can set the TM-D710A/E for tone squelch instead of carrier squelch, and the rig 

will “open up” only during the time a station is speaking.  This prevents the repeater’s tail, courtesy 

tone, and other incidental sounds from being heard at the other end of the link, without affecting 

the repeater’s operation for local users.
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8.3 Using EchoLink only with Amateur Radio Equipment

If there is an EchoLink node within range of your transceiver, it is possible for you to access the 

node and communicate via your transceiver with distant stations using the node.  

You can search for nearby nodes at the EchoLink site at http://www.echolink.org.

Access the EchoLink site and click on “Link Status” in the menu on the left side of the screen. 

Figure 8-2   EchoLink Home Page

Input your current location information (or the location where you would like to search for a node).

Figure 8-3   EchoLink Link Status Page

Input the longitude and latitude data, or the grid square locator, of your current location if you have 

this data.  Or input your city name or the name of the largest city in your vicinity into “City”.  Select 

the correct “State/Prov” and “Country” from the pulldown lists.  Select the “Show Links Near:” 

button on the left side of the screen beside the information entered.  Click the “Find” button. 

Nearby nodes will be displayed.

http://www.echolink.org
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Figure 8-4   Finding Nearby EchoLink Nodes

Selecting “Online Only” in the pulldown list to the left of the “Find” button results in search results 

being displayed only for those nodes currently connected to the EchoLink server. 

“-L” at the end of a node callsign, such as “W4DJY-L”, indicates a link station (simplex operation). 

“-R” at the end of a node callsign, such as “W5DJY-R”, indicates a repeater station (semi-duplex 

operation). 

The frequency of the node is indicated in Freq (MHz).  Other node data is included too, such as 

access tone frequency, transmit power and height/ gain/ pattern for its antenna.

When “In Conference *xxxxxxxx*” is indicated under Description, the node is presently already 

connected to a conference (a round-table QSO room) called “xxxxxxxx”.

Once you verify that there is a node that may be accessible, you can verify access possibilities.  

Configure the frequency of your transceiver for the node frequency.  If a tone access frequency 

(e.g. 77.0 Hz) is shown, configure this frequency in order for the transceiver to send an encode 

tone.  Before transmitting, carefully listen on the frequency and first verify whether anybody is 

already communicating with the node.

Note: We recommend that you verify the state of nodes using the official EchoLink site via the Internet.  The information 
presented is kept up-to-date almost in real time. 

When no communication is heard, check if it’s possible to communicate with the node.  Press the 

PTT switch and use the keypad to transmit the “08” DTMF code (command for state verification).  

When the node is available to use, a signal will be returned from the node.  A “Not connected” 

announcement means the node is not connected to another station or a conference.  An 

“EchoLink disabled” announcement means the EchoLink software is inactive so you cannot use 

the node.  When there is no reaction at all from the node, it is possible that the node is not working 

or is outside communication range.  In that case, try verifying another node. 
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8.3.1 Basic Commands used for EchoLink

These commands are a representative set of basic commands.  There are many commands in 

addition to these.  For details, refer to the EchoLink site at http://www.echolink.org/Help/

dtmf_functions.htm.

Note: Each node owner has the option of changing the basic commands, particularly to avoid conflicts with other repeater 
functions.  Before using EchoLink over a nearby repeater, it is a good idea to try to contact the node owner, or 
someone else familiar with the node, to see if there are any special operational rules.

8.3.2 EchoLink Memory Function of TM-D710A/E

You use this function for accessing nearby relay stations by using DTMF codes from 

a TM-D710A/E or by transmitting a control command to the relay station.  It is possible to register 

a DTMF code up to a maximum of 8 digits in an EchoLink private DTMF memory (10 channels all 

together). 

8.3.2.1 Storing to an EchoLink Memory

1. Select Menu 204.

2. Turn the Tuning Control to select an EchoLink memory channel from [EL0] to [EL9].

3. Press the Tuning Control.

� The name input screen will appear. 

4. Enter the EchoLink memory name.

� Enter the callsign of the target station that you want to call via EchoLink and the name of the 

conference or the control command.  Conference rooms allow you to have roundtable 

QSOs.

5. Press the Tuning Control.

� The code input screen will appear.

6. Enter the EchoLink code.

� Enter the target station that you want to call via EchoLink and the node number of the 

conference or the DTMF code, such as a control command.

Command Description Default

Connect Connects to a station on the Internet, based on its node number. num

Connect by Call Connects to a station on the Internet, based on its callsign. C+call+#

Disconnect
Disconnects the station that is currently connected.  If more than one station is 

connected, disconnects only the most-recently-connected station.
#

Disconnect All Disconnects all stations. ##

Reconnect Re-connects to the station that most recently disconnected. 09

Status Announces the callsign of each station currently connected. 08

Play Info Plays a brief ID message. *

Query by Call Looks up a station by its callsign, and reads back its node number and status. 07+call+#

Query by Node Looks up a station by its node number, and reads back its callsign and status. 06+num

http://www.echolink.org/Help/dtmf_functions.htm
http://www.echolink.org/Help/dtmf_functions.htm
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8.3.2.2 Transmitting with an EchoLink Memory

1. Press the PTT switch to transmit.

2. Press the Tuning Control while transmitting.

� The transceiver enters the EchoLink memory channel selection mode.

3. Turn the Tuning Control while the PTT switch is pressed to select the EchoLink memory 

channel on which you want to transmit.

4. Press the Tuning Control while the PTT switch is pressed.

� Until transmission of the EchoLink code ends, the transceiver remains in transmit mode even 

if you stop pressing the PTT switch.

Useful Tips:

� In Step 2 above, if before pressing the Tuning Control, the [C] key on the microphone is 

pressed, then the DTMF code for the EchoLink “Connect by Call” function is transmitted.

For example, in the case of JA1YKX: “C” “51 21 10 93 52 92 #” (“#” will be added at the end 

automatically).

� In Step 2 above, if before pressing the Tuning Control, the [0] and [7] keys on the microphone 

are pressed, then the DTMF code for the EchoLink “Query by Call” function is transmitted.

For example, in the case of JA1YKX: “0” “7” “51 21 10 93 52 92 #” (“#” will be added at the end 

automatically).

� When only the EchoLink memory name is stored, the DTMF code for the EchoLink “Connect by 

Call” function is transmitted.

For example, in the case of JA1YKX: “C 51 21 10 93 52 92 #” (“C” will be added at the 

beginning and “#” will be added at the end automatically).

Note: When converting a callsign to a DTMF code, when a character is encountered other than the alphanumeric characters 
in Table 8-1, such as “-”, “/”, etc., the DTMF conversion halts at the letter prior to the character not found in the table.

Table 8-1   Callsign/ DTMF Code Conversion Table

� Speed of DTMF transmission from an EchoLink memory can be changed between FAST and 

SLOW using Menu 520.  The default is FAST.  When a node does not decode your DTMF 

signal correctly, configure the SLOW setting to increase chances of the node correctly decoding 

your DTMF signal.

              1st

  2nd
1 2 3 4 5 6 7 8 9 0

0 1 2 3 4 5 6 7 8 9 0

1 Q A D G J M P T Y

2 Z B E H K N R U X

3 C F I L O S V Y



8 EchoLink

TM-D710A/E CONTENTS 47

8.4 Using EchoLink only with a Computer

If the EchoLink software is installed on your personal computer, without using any transceiver, it is 

possible to communicate as a single user directly via your personal computer.  In addition, when 

you set up a link station, by connecting a TM-D710A/E and a personal computer, we recommend 

you make it possible to use EchoLink software in Single User mode as an advanced preparation.

8.4.1 Downloading EchoLink Software

Access the EchoLink site (http://www.echolink.org) and click “Download” in the menu on the left 

side.

Figure 8-5   EchoLink Software Download Access Page

Figure 8-6   Registering Prior to Downloading Software

The Download EchoLink page will appear on your screen.  Enter your callsign and email address, 

and then click the “Submit” button.

Figure 8-7   EchoLink Software Download Link Page

http://www.echolink.org
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The Download EchoLink page with a download link will appear.  Double click “Click Here to 

Download”.  The download will begin.

Figure 8-8   EchoLink Software Download Security Warning

Select the appropriate folder and save the file to this folder.

8.4.2 Installing EchoLink Software

Click the icon  of the file you downloaded called “EchoLinkSetup_X_X_XXX.exe” (X_X_XXX is 

the version number), and then click the “Run” button.  Follow the procedure presented on screen.  

When installation is finished, “InstallShield Completed” will appear.  Then click the “Finish” button.

8.4.3 Starting EchoLink Software

Start EchoLink software by clicking the EchoLink icon  which was created by the installation.

Figure 8-9   EchoLink Setup Wizard Window

The Setup Wizard window will appear with a welcome message.
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Figure 8-10   EchoLink User Type

Select “Computer User” and then click the “Next >” button.

Figure 8-11   Type of Connection 

Unless you are using an analog modem (56k or less) to dial up to an ISP (Internet Service 

Provider), select “DSL, cable, ISDN, or other (above 56k)” and then click the “Next >” button.

Figure 8-12   EchoLink Personal Information Window

Continue configuration by entering your personal information, and then clicking the “Next” button.

Note: Do not forget the password that you entered in the Password edit box.  Because you will need the password for a later 
process in EchoLink.
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Figure 8-13   Setup Complete Window

Click the “Finish” button.

Figure 8-14   Validation Advisory Window

When validation of your callsign is necessary, a validation advisory window will appear.  Click the 

“OK” button and proceed to the Validation procedure.

8.4.4 Validation of EchoLink User’s Callsign

Begin the EchoLink Validation process by clicking “Validation” in the menu on the left side of the 

EchoLink home page.

Figure 8-15   EchoLink Validation Page
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Enter your callsign and click the “Continue” button.  The callsigns available for validation will 

appear.

Figure 8-16   Callsigns Available Page

When the software was configured via the Setup Wizard as a Computer User, only your callsign 

(without -L or  R at end of callsign) is shown to represent a single user.  Confirm the callsign is 

selected (small black circle to left of callsign).  This callsign becomes the validation object.  Enter 

your email address and click the “Request Validation” button.

Figure 8-17   Confirmation of Sending the Validation Procedure

The message in Figure 8-15 will appear and the URL that has the Validation procedure for your 

callsign will be sent to the email address you enter.  Click the URL in the email that you receive.

Figure 8-18   License Submission Page

Click the method that you want to use to validate your callsign.  A valid amateur radio license is 

mandatory to complete the validation.
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8.4.4.1 Scan and Upload 

Use a digital camera or scanner to create a graphics file of your license.  Click “Scan and Upload”.  

Enter the necessary information and upload the license file.

Note: Be sure to follow the tips below:

� File must be .jpg, .gif, .png or .tiff format.

� Size of file must be less than 5 MB.

� Callsign and other information on the license image must be legible.

When upload completes, a screen indicating “Validation-Upload” appears.  Another message 

appears (“Processing...Your validation request will now...”) that indicates the request for validation 

has been accepted.

The process for validation is done by a support team of volunteers.  When the validation process is 

completed, you will receive an email that contains the notice of approval of validation.  The email 

will indicate “Validation approved for...”.  Typically, the validation process usually completes within 

24 hours.

8.4.4.2 Fax

Click “Fax”.  Send your amateur radio license by fax to the telephone number presented on the 

page.  In this case, you will not receive a reply by fax.  When the validation process is completed, 

you will receive an email that contains the notice of approval of validation from the support team.

After receiving validation, the list of callsigns should appear on the EchoLink screen within a few 

minutes.

8.4.5 Startup in Single User Mode

Connect a PC headset (or microphone and speaker) to your computer and start the EchoLink 

software.  The “Tip of the Day” window will appear.  

Figure 8-19   EchoLink “Tip of the Day” Window
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Stations that are currently connected to EchoLink will appear on the screen.  This screen will 

automatically update as changes occur.

Figure 8-20   EchoLink Startup Window

8.4.6 Setting Audio Levels

Before starting to make QSOs, first connect to the Test Server and configure the correct receive 

volume.

Figure 8-21   Connecting to EchoLink Test Server

There are two ways to connect to the Test Server as follows:

� Select “Connect to Test Server” from the Station pulldown menu.

� Select the *ECHOTEST* conference and click the “Connect” button (upper left corner of 

screen).

“Connecting to *ECHOTEST*...” will appear.  Once connected, you will hear an announcement 

from the test server that begins: “Welcome to the EchoLink Test Server...”.
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8.4.6.1 Adjusting Receive Volume

Adjust the receive volume of the announcement audio from the test server.

Select “Adjust Sound Device” > “Playback...” from the Tools pulldown menu.

Figure 8-22   Receive Volume Menu Selection

Adjust the appropriate volume control using the test server announcement.

8.4.6.2 Adjusting Transmit Level

Adjust the level of the transmit audio that is sent from the microphone to the test server.

Select “Adjust Sound Device” > “Recording...” from the Tools pulldown menu.

Figure 8-23   Transmit Level Menu Selection 

To transmit, use the “Transmit” button on the EchoLink software screen or the [Space] key on 

your computer keyboard.  Press the “Transmit” button or [Space] key once to activate the transmit 

mode; press it again to return to receive mode.

Figure 8-24   Adjusting Transmit Level

While transmitting, speak into the microphone using a normal level of voice.  After returning to 

receive, your spoken audio will be repeated back by the test server.  Adjust the microphone level 

control until the returned audio sounds best.  Transmit to the test server and listen to the returned 

audio a couple of times.  When you have completed setting the input level, press the “Disconnect” 

button on the EchoLink software screen to disconnect from the test server.
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8.4.7 Connecting with a Station

Figure 8-25   Connecting with a Station

Connected stations are listed in the Station List of the Index View tab on the EchoLink software 

screen.  The stations are listed in order of repeater stations, link stations, single user stations (PC 

users) and conferences in the chart.  First, choose a single user station and connect to it.  If 

connecting to a repeater station, link station or conference, before pressing the space bar to 

transmit, monitor sufficiently to understand who else may already be connected.

8.4.8 Port Forwarding (Router Configuration)

With older versions of EchoLink, router configuration and understanding port forwarding was 

always the source of most confusion for new users.  With the current version of the software, in 

many cases it is no longer necessary to make firewall adjustments.

The latest version of EchoLink software, Ver. 2.0.908 was released in February 2007.  The feature 

that avoids many firewall issues is included in this version.  The EchoLink server support for this 

feature began in September 2007.  You can read more on this subject at 

http://www.echolink.org/firewall-friendly.htm.

Note: Ver. 2 and later of EchoLink software allows connections to the conference server and EchoLink node stations that are 
using EchoLink Ver. 2 or newer software without configuring port forwarding.  Previously, it was necessary to open 
TCP 5200/ UDP 5198-5199 ports.  However, if the stations that you want to connect to are still using Ver. 1.x EchoLink 
software, then it will still be necessary for you to configure port forwarding at your location as before.  This may also be 
necessary when using more restrictive firewalls.

8.4.9 Firewalls

When you cannot connect to a station while in Single User mode (PC single unit) in spite of having 

installed an up-to-date version of EchoLink software, there is a possibility that the TCP 5200/ UDP 

5198-5199 ports that EchoLink uses are being blocked by a firewall and the Windows security 

software.  If you suspect this, follow the procedure below.

8.4.9.1 Windows Firewall

In Windows, select Start > Settings > Control Panel > Security Center > Windows Firewall > 

Exceptions.  Verify that “EchoLink” is included in the program list and the checkbox is checked.

8.4.9.2 Security Software Firewall

Examine the Help file of your security software and configure the security software so that 

EchoLink software is able to connect to the Internet.  If necessary, consult with the support group 

of the manufacturer of the security software to be certain the EchoLink software is not being 

blocked from accessing the Internet.

http://www.echolink.org/firewall-friendly.htm
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8.5 Setting Up a Node Station (Link Station) with 
TM-D710A/E

With the optional PG-5H cable kit, the TM-D710A/E can be connected directly to a computer to run 

the EchoLink software in Sysop mode.  In Sysop mode, EchoLink forms a gateway between the 

Internet and a local RF channel, such as a simplex frequency or a nearby repeater.  This allows 

other nodes on the EchoLink system to communicate with mobile or portable users in your area.  

Other EchoLink users can connect to your node, or local mobile and portable users can use the 

DTMF pad on their transceivers to connect your EchoLink node to other nodes on the system.

The TM-D710A/E connects to the sound card and serial port of your computer.  The sound card 

connection handles the transmitted and received audio, and the serial-port connection takes care 

of PTT control and carrier detect.  This allows the EchoLink software to key and un-key the 

TM-D710A/E’s transmitter, and to detect the presence of a signal received by the TM-D710A/E.

8.5.1 Connecting a PC

The Kenwood PG-5H is a package of two different cables.  Following the instructions in the 

TM-D710A/E Instruction Manual, connect the cables to the two jacks on the back of the 

transceiver and to the serial port and sound card jacks of your computer.  The pink plug goes to 

the microphone input of the sound card, and the green plug goes to the sound card’s line out (or 

speaker out).  The black 9-pin connector goes to the computer’s serial port.

Many modern computers have USB ports, but no serial ports.  If your computer has no serial port, 

you will need to use either a USB-to-serial adapter cable, or a serial port option card.  Either can 

be purchased from stores that sell computer accessories.

Figure 8-26   Connecting a TM-D710A/E and a PC

Data communications cable

To PC audio terminal

Pink:  To microphone input terminal
Green:  To line out terminal

To PC 9-pin D-SUB 
terminal

PG-5H Cable Kit
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8.5.2 Configuring EchoLink Software for a Link Station

If your computer is already configured for use in Single User mode of EchoLink, you can easily set 

up a link station.  Select “Setup...” from the Tools pulldown menu to open the System Setup 

window.

Figure 8-27   System Setup Window

In the My Station tab, change the configuration in the Mode frame from “Single-User” to “Sysop”.  

That is, select the Sysop radio button.  Click the “Change Callsign” button.

Figure 8-28   Callsign Change Confirmation

A confirmation message appears that asks you to confirm that you want to change callsign.  

Click the “Yes” button.



8 EchoLink

58 CONTENTS TM-D710A/E

Figure 8-29   Changing Callsign to be a Link Station

Enter in the Callsign edit box your callsign with -L at the end such as W6DJY-L.  Click the “OK” 

button.

Figure 8-30   Validation Required Message

A server message will display that indicates the new callsign must be validated.  You must close 

the EchoLink software and validate this new callsign as a link station.

Note: As shown in the example below, the link station callsign is treated as a different station even if the same callsign 
(without the -L) has been validated previously.  In the case of “W6DJY”, the EchoLink software differentiates between 
“W6DJY” (single user), “W6DJY-L” (link station) and “W6DJY-R” (repeater station), and different node numbers will be 
assigned.  Because of this, you must validate a link station (or repeater station) callsign by going to 
http://www.echolink.org/validation and following the validation procedure.

http://www.echolink.org/validation
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Figure 8-31   EchoLink Validation Page

Enter your callsign and click the “Continue” button.  The callsigns available for validation will 

appear.

Figure 8-32   Callsigns Available Page

Confirm the callsign is selected (small black circle to left of callsign).  This callsign becomes the 

validation object.  Enter your email address and click the “Request Validation” button.  In the same 

way as the validation you did for Single User mode, the URL that has the Validation procedure for 

your callsign will be sent to the email address you enter.  Click the URL in the email that you 

receive.  The License Submission Page shown in Figure 8-33 will appear.

Figure 8-33   License Submission Page
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Click “Password”.  The page shown in Figure 8-34 appears.

Figure 8-34   Password Entry Page

Select the new link station, enter the password you configured during the first validation process 

and click the “Continue” button.  “Verifying password...” will display, and then “Password verified” 

will display within 1 minute.

Figure 8-35   Password Verification Page

This is the completion of the Validation procedure of a callsign for a link station.  Re-start the 

EchoLink software.

Figure 8-36   EchoLink Startup Window

Your link station callsign will be displayed at the top of the screen in the Title bar and stations 

connected to EchoLink are shown.  The software will already be connected as a link station.  Next, 

select “Sysop Settings” from the Tools pulldown menu and open the Sysop Setup window.  Click 

the RX Ctrl tab.
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Figure 8-37   Sysop Setup Window: RX Ctrl Tab

Select the “Serial CTS” radio button in the Carrier Detect frame.  Configure the “Serial Port” 

dropdown list for the port used for EchoLink.  Confirm the correct serial port to use by examining 

your computer configuration; the correct port depends on your particular computer.

If MCP-2A is installed, usually this software uses the same port as EchoLink software.  When 

there is only one COM port on a computer, it is usually COM1.  If a USB-serial conversion cable is 

being used, the correct COM port number may be COM2 or larger.

Do not check the Invert Sense check box for the TM-D710A/E and TM-V71A/E transceivers.  This 

is to set the Output Logic of Squelch Control from the transceiver to “Active High”.  Refer to Step 3 

of Parameter Settings in Section 8.5.4 Using MCP-2A to Configure TM-D710A/E.  It is not 

necessary to check the Squelch Crash Anti-Trip check box either.  Next, click the TX Ctrl tab.

Figure 8-38   Sysop Setup Window: TX Ctrl Tab

Select the RTS radio button in the PTT Activation frame.  The “Serial Port” will be the same port 

as configured in the RX Ctrl tab.  It is not necessary to check the 9600bps or Key PTT on Local 

Transmit checkbox.  Next, click the DTMF tab.
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Figure 8-39   Sysop Setup Window: DTMF Tab

Select the Internal radio button in the DTMF Decoder frame.  In order for you to administer your 

link station, we recommend that you input a DTMF command for LinkDown and LinkUp for the 

EchoLink server.  Keep these commands private to prevent any unauthorized person other than 

the link station manager from gaining administrative control of the station.  Click the Ident tab.

Figure 8-40   Sysop Setup Window: Ident Tab

Configure in the Station Identification frame the type of station ID that will be automatically 

transmitted for identification purposes.  Choose the correct form of over-the-air legal ID for your 

local area.  The callsign entered here does not necessarily need to match the callsign used for 

your EchoLink login.  If the “Spoken Voice” radio button is selected, the EchoLink software uses 

speech synthesis to announce the station callsign.  If the “Morse” radio button is selected, an ID 

will be sent by Morse code.

Check the While Active checkbox and configure the ID interval for sending the ID.  If the Wait for 

clear frequency checkbox is checked, the ID will only be transmitted after the frequency becomes 

clear.  Next, click the Options tab.



8 EchoLink

TM-D710A/E CONTENTS 63

Figure 8-41   Sysop Setup Window: Options Tab

The initial settings are fine to use.  No changes are necessary.  Finally, click the RF Info tab.

Figure 8-42   Sysop Setup Window: RF Info Tab

At this point, you must enter your link station information.  While initially experimenting and setting 

up your station, it’s best not to enter this information.  This information is sent to the EchoLink 

server.  After you disconnect from the EchoLink server, this information will continue to be public 

via the server for some time.  Heed this warning!

This is the information that you can enter:

Lat: Enter latitude.

Lon: Enter longitude.

Freq: Enter operational frequency.

PL (if any): Enter Tone frequency for access (e.g. the CTCSS frequency configured in 

a TM-D710A/E).

Power (W): Select from the dropdown list the power closest to your transmit power.

HAAT (ft): Select from the dropdown list the height closest to your antenna height.

Antenna Gain (dB): Select from the dropdown list the gain closest to your antenna gain.

Directivity: Select from the dropdown list the direction of maximum antenna gain.  For an 

omnidirectional antenna, select “Omni”.

Report Status via APRS: Do not check.
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When operational frequency, Tone frequency, etc. are modified, after you connect to the EchoLink 

server, all modified information will be transferred at one time.  Click the “OK” button to complete 

the settings.

8.5.2.1 Finding your Position (Latitude/ Longitude Coordinates)

Besides using a GPS receiver, it is possible to use web sites on the Internet and software to 

acquire your latitude and longitude coordinates.

Using Google Earth

Google Earth allows you to search for your position by typing your street address into the 

Google Earth search box.  Once Google Earth zooms into your vicinity, move the mouse cursor 

to rest exactly on your position on the map.  At the bottom of the screen, you can read your 

latitude and longitude: e.g. “33° 50' 25.80" N  118° 13' 43.26" W”.  This indicates a North 

latitude of 33 degrees 50 minutes 25.80 seconds and West longitude of 118 degrees 13 

minutes 43.26 seconds.  EchoLink software does not use the minutes/seconds format.  The 

minutes/ seconds values must be converted into a decimal value with two digits following the 

decimal point by using the formula 1 minute = 60 seconds.  Therefore, the Google Earth values 

convert to 33 degrees 50.43 minutes North and 118 degrees 13.72 minutes West.

In the RF Info tab in the Sysop Setup window, enter as follows:

Lat 33 50.43 North

Lon 118 13.72 West

Up to this point, basic settings for configuring a link station when using a TM-D710A/E have 

been discussed.  For more detailed configuration information, refer to the Help files in the 

EchoLink software.  Furthermore, adapt the specified configurations for your environment so 

you can enjoy comfortably operating a link station.

8.5.3 Configuring a TM-D710A/E for a Link Station

8.5.3.1 What is TM-D710A/E EchoLink Sysop Mode?

EchoLink Sysop mode is the mode used when connecting the TM-D710A/E with a personal 

computer and operating as a base station at an EchoLink relay station (link station).  In EchoLink 

Sysop mode, the computer interfaces its RTS and CTS hardware flow control signals to the PKS 

(transmit control signal input from the computer) and SQC (squelch control signal output to the 

computer) terminals respectively on the TM-D710A/E.

The operation band is the data band as selected via Menu 517 regardless which band you 

transmit on by pressing the PTT switch or currently have selected.

Use a PG-5H cable kit to connect a personal computer installed with EchoLink software to the TM-

D710A/E as shown in Figure 8-43.
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Figure 8-43   Computer to TM-D710A/E Connections

1. Turn the power OFF.

2. Hold [PF2] down and turn the power ON.

Whenever Steps 1 and 2 are done, the EchoLink Sysop mode turns On and Off.

Note: 

When EchoLink Sysop mode is On, the  icon appears.

When an audio signal is output from the data terminal to the personal computer, the  icon blinks.

When the personal computer has no RS-232C ports, then use a USB-to-serial conversion cable.

When EchoLink Sysop mode is On, the transceiver cannot communicate with MCP-2A Programming Software.  Before 

using MCP-2A, turn EchoLink Sysop mode Off.

8.5.4 Using MCP-2A to Configure TM-D710A/E

1. Select “Menu” > “Aux” from the Edit pulldown menu.  Confirm “1200” bps is configured for “Data 

Speed [bps]”.  Data Speed can also be confirmed using Menu 518 on the transceiver.

2. Configure “SQC Output Source” for “SQL” in the dropdown list.  This is the same as Menu 520 

on the transceiver.

Figure 8-44   MCP-2A Aux Window: Data Speed and SQC Output Source

Internet

To PC audio terminal

Pink:  To microphone input terminal
Green:  To line out terminal

To PC 9-pin D-SUB terminal 

PG-5H Cable Kit



8 EchoLink

66 CONTENTS TM-D710A/E

3. Select “Menu” > “Transmit/Receive” from the Edit pulldown menu.  When using CTCSS or DCS 

for the purpose of preventing extraneous signals or noise from being fed into the Internet from a 

link station, configure “EchoLink RX Monitor” for “Busy Only” in the dropdown list.  When 

EchoLink Sysop mode is used, all signals received on the data band are output from the 

speaker regardless whether CTCSS or DCS has matched; whereas, only those signals that 

match CTCSS or DCS are output from the data terminal.

Figure 8-45   MCP-2A Transmit/Receive Window: EchoLink RX Monitor

4. Select “Data Terminal” from the Edit pulldown menu.  Configure “SQC Output Logic” for “High” 

in the dropdown list so that a false Busy state is never detected, even when the transceiver is 

turned OFF.

Figure 8-46   MCP-2A Data Terminal Window: SQC Output Logic

Note: In the Sysop Setup window in EchoLink software, do not check the Invert Sense checkbox in the RX Ctrl tab.  
Refer to 8.5.2 Configuring EchoLink Software for a Link Station.

5. Select “Data Terminal” from the Edit pulldown menu.  If the audio level adjustment range on 

your computer is not sufficient, configure “PR1 Pin Output Level” to adjust the AF output level to 

the computer.  Also, configure “PKD Pin Input Level” to adjust AF input sensitivity that will vary 

the AF signal level fed into the transceiver.  These levels can be varied using steps of 

approximately 6 dB. 

Figure 8-47   MCP-2A Data Terminal Window: AF Level Adjustments
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Note: 

Steps 3 through 5 above can only be done using MCP-2A.

Older versions of MCP-2A may not have menu items described above.  In this case, upgrade your MCP-2A to version 
3.10 or newer.

8.5.5 Checking your Link Station

Here are the steps to follow to check out your link station:

� Connect a dummy load to the TM-D710A/E antenna connector in place of the antenna.  This 

will prevent your transmitted signal from interfering with others while you prepare the link station 

for use.

� Turn ON the power to TM-D710A/E while holding down [PF2] to place TM-D710A/E in 

EchoLink Sysop mode.

� Start the EchoLink software.

� Pressing the PTT switch on another transceiver configured to operate on the TM-D710A/E 

frequency should cause the EchoLink software to show a Busy indicator. 

� Connect to the test server the same as in Single User mode.  Adjust receive and transmit levels 

by using another transceiver in place of the headset used in Single User mode.  

� Adjust the modulation of TM-D710A/E to produce an adequate level from the computer to the 

test server.  Adjust the deviation of TM-D710A/E such that the signal received from the test 

server via the computer is adequate.

� The [Ctrl] + [F10] keys on a PC can be used to manually toggle the transceiver’s PTT on and 

off, to test the cable connections and TX Ctrl configuration.

� After completing the above adjustments, try transmitting DTMF signals from another 

transceiver.  Verify that the DTMF signal is decoded correctly on the screen of the EchoLink 

software.

� Disconnect from the test server when the verification is complete.

� Transmit DTMF signals from another transceiver to verify commands such as Connect/ 

Disconnect or LinkUp/ LinkDown are working correctly.

After completely verifying all operations, your node setup is done.  Enjoy operating EchoLink with 

your TM-D710A/E.
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9  MCP-2A Memory Control Program 
(for use with TM-V71A/E, TM-D710A/E, RC-D710)

MCP-2A is software designed for use with your personal computer to edit and manage memory 

channel and menu data for TM-V71A/E, TM-D710A/E or RC-D710.  The current version of 

MCP-2A retains features from earlier versions of MCP series software that received favorable 

comments from customers, and introduces new features to substantially raise the overall software 

performance.  For convenience of customers, Kenwood distributes the software via our corporate 

web site as a free service for our customers.

This version updates and improves the user 

interface to allow a user to view much 

information at one time in a single window.  A 

new file import/ export function has been added 

that can be used to import the ARRL-issued 

TravelPlus for Repeaters™ information.  Also, 

the file format of the new MCP-2A is compatible 

with the older version of software.

Create, manage and edit memory channel and 

menu data for TM-V71A/E, TM-D710A/E and 

RC-D710 to maximize your enjoyment of these 

transceivers.  Furthermore, using the MCP-2A 

software tool makes exchanging this data 

among transceivers easy.  You will need a 

PG-5G or PG-5H cable kit available as an 

option to use MCP-2A.

Figure 9-1   MCP-2A Memory Channel Window

9.1 Downloading and Installing MCP-2A

1. Check that the specifications for your computer meet the following that are necessary to use 

MCP-2A.

Table 9-1   MCP-2A Computer Specifications Table

Note: 

If using Windows Vista, it is not necessary to install the run-time environment specified above.  Otherwise, if Microsoft 

.NET Framework 2.0 (or later) is not installed, download the software from the following URL and install it prior to installing 

MCP-2A:  http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-

aab15c5e04f5&displaylang=en

Use the following procedure to determine if Microsoft .NET Framework 2.0 (or later) is installed on your computer.  The 

example shown is for Windows XP.

Click “Start” > “Control Panel” > “Add or Remove Programs”.  You should see “Microsoft .NET Framework 2.0” (or later) in 

the list of installed software.

Depending on the type of computer, there may not be any equipped COM ports.  In this case, you will need a USB-to-serial 

port conversion cable.  Details of USB-to-serial conversion for use with APRS and TM-D710A/E can be obtained from the 

amateur radio community.

2. Download the newest version of MCP-2A from the Kenwood web site URL shown below (URL 

is subject to change).  MCP-2A download location: http://www.kenwood.com/i/products/info/

amateur/mcp_2a.html

Personal Computer Required Specification

Operating System Windows 2000 (SP4 or later), Windows XP (SP2 or later), Windows Vista (32-bit version)

CPU Pentium II 450 MHz or faster, or CPU recommended by OS

Memory Larger than OS recommended capacity 

Run-time 

Environment
.NET Framework 2.0 or later (see Notes below) 

Communication Port Serial port available (COM1 to COM20). (see Notes below)

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en
http://www.kenwood.com/i/products/info/amateur/mcp_2a.html
http://www.kenwood.com/i/products/info/amateur/mcp_2a.html


9 MCP-2A Memory Control Program (for use with TM-V71A/E, TM-D710A/E, RC-D710)

TM-D710A/E CONTENTS 69

3. Click the icon of the downloaded software.  

Follow the Wizard installation instructions 

presented on screen.

Note: 

Windows Vista requires that you click the “Allow” 
button when the User Account Control window 
displays a message asking permission to install the 
software.

Installing MCP-2A alone without first installing 
Microsoft .NET Framework 2.0 (or later) will result in 
MCP-2A not being able to start.  Microsoft .NET 
Framework 2.0 (or later) must be installed first.  
Windows Vista does not require Microsoft .NET 
Framework 2.0 (or later) since this newer version of 
Windows already contains the necessary 
environment software.

Figure 9-2   Windows Vista 

User Account Control Window

4. Click “Start” > “Program” > “KENWOOD” > 

“MCP-2A” to start MCP-2A. 

When MCP-2A starts, the transceiver 

model is requested.  Select the correct 

transceiver model and click the “OK” 

button.  You can modify the model later if 

necessary.

Figure 9-3   MCP-2A Product Select Window

5. Select the communication port and data 

rate.

Specify in the COM Port frame the COM 

port that will be used to communicate via 

your computer with the target station.  You 

cannot select grayed out ports.  If all ports 

are grayed out, this indicates your 

computer has no COM ports installed and 

you will not be able to use the MCP-2A 

software even if you click the “OK” button.

Figure 9-4   MCP-2A COM Port Setting Window
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6. Finish the installation.  The fact that 

information is read from the target 

transceiver completes the MCP-2A 

installation.

Click the “OK” button, select “Read Data 

from the Transceiver” from the Program 

pulldown menu and read the information 

from the target transceiver.

Note: The basic method of using MCP-2A is to read 
the existing transceiver data into MCP-2A, edit 
the configuration, and then write the new 
configuration back to the transceiver. 

Figure 9-5   MCP-2A Read Transceiver 

Advisory Message

Figure 9-6   MCP-2A Program Menu: 

Read Data from the Transceiver
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9.2 Main Functions of MCP-2A

MCP-2A has many functions.  This section lists the most commonly used functions of MCP-2A 

including importing files.

9.2.1 Main New Functions Added

� Imports and exports memory channels.

� Outputs files in html format.

� Inputs memory channels from tabular format.

9.2.2 Useful Functions of MCP-2A

� Creates main memory groups and PM (Programmable Memory).

� Reads and retains memory channel and other data.

� Imports/ exports memory channels.

� Imports files that have been exported from ARRL’s TravelPlus for Repeaters.

� Imports files created by earlier versions of MCP series software (see Note below).

� Changes font sizes.

� Indicates user name/ callsign.

9.2.3 Functions Only Configurable by MCP-2A

� Selecting monitor method for EchoLink Sysop mode.

� Switching SQC active conditions.

� For packet transmission or EchoLink Sysop mode, changing the input sensitivity for the data 

terminal and configuring the output level.

� Selecting 10 MHz steps for the VFO.

� Configuring the character string for the power on password.

Note: Regarding files created with the other MCP series software for products other than TM-V71A/E and 
TM-D710A/E, it is possible to read the memory channel data. 
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9.3 Importing Other MCP Files into MCP-2A

With MCP-2A, it is possible to read a file that 

was created using other MCP series software.  

To read a file created by other MCP software, 

select “Open” from the File pulldown menu.  

In the Open window, select the correct file 

type in the “Files of type” dropdown list, and 

open the desired file.

Figure 9-7   MCP-2A Open Window

The files that were created by other MCP programs (except J-type) in the table below can be 

imported into MCP-2A.  The referenced software can be downloaded from the following web site: 

http://www.kenwood.com/i/products/info/amateur/software_download.html.

Table 9-2   MCP-2A Importable File Formats Table

Only files created for K-type (U.S.A. and Canada) models can be imported into MCP-2A.  The 

referenced software can be downloaded from the following web site: http://www.kenwoodusa.com/

Support/AMA_Radios/.

Software Name 

and Extension
Transceiver Model Remarks

MCP-2000 (*.2k0)

TS-2000

TS-2000X

TS-B2000

Unable to read memory channels that cannot be received by using  

TM-V71A/E and TM-D710A/E.

TS-B2000 is only for overseas models (outside Japan).

MCP-D7G (*.d7g)

TH-D7A(G)

TH-D7A(G2.0)

TH-D7E(G2.0)

Only for overseas models (outside Japan).

TH-D7 J-type (Japan) is unable to use due to command 

specification differences.

MCP-2A (*.mcp)

TH-K2AT/ TH-K2E/ 

TH-K2ET/ TH-K4AT/ 

TH-K4E/ TM-271A/ 

TM-271E

MCP-F6/F7 (*.fx)
TH-F6A/ TH-F7A/ 

TH-F7E

Memory channels that are outside of the receive frequency range 

of TM-D710A/E or TM-V71A/E cannot be read.

MCP-D700 (*.700)
TM-D700A/ 

TM-D700E

MCP-D7 (*.d7) TH-D7A/ TH-D7E

http://www.kenwood.com/i/products/info/amateur/software_download.html
http://www.kenwoodusa.com/Support/AMA_Radios/
http://www.kenwoodusa.com/Support/AMA_Radios/
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Table 9-3   MCP-2A Importable File Formats Table (K-type only)

Note: 

MCP-2A is unable to read memory channels that cannot be received by using TM-V71A/E and TM-D710A/E.

With MCP-2A, it is not possible to exchange data between above-mentioned transceivers except TM-V71A/E or TM-D710A/E.

MCP-2A cannot read DTMF memory and menu settings, etc. from the above-mentioned transceivers except TM-V71A/E 

or TM-D710A/E.

For TM-V71A/E, due to its display with six columns of 13 digits, there are times when some characters used in a memory 

name cannot be read depending on how the data was originally produced.  For TM-D710A/E, due to its dot matrix display 

with eight columns, a memory name will appear the same as the original.

Although you may be able to import an MCP file that is not explained in the above tables, some data in the file may not be 

read into the MCP-2A program.

9.4 Importing .hmk Files Created by Another MCP-2A

To exchange a file with MCP-2A where the market code does not agree, file exchange is possible 

via the .hmk file type.  It is possible to import this file with MCP-2A.  To output MCP-2A channel 

data as a file that can be exchanged with another MCP-2A, export .hmk files by selecting “Export” 

> “HMK File” from the File pulldown menu.

On the other hand, to import a .hmk file, import it by selecting “Import” > “HMK File” from the File 

pulldown menu.  

Note: By starting the MCP-2A software multiple times, it is possible to copy and paste memory channel data between 
MCP-2A open windows.

Software Name and 

Extension

Transceiver 

Model
Remarks

MCP-G707 (*.707) TM-G707A

Only for U.S.A. and Canada models.

Unable to use other than K-type (U.S.A. and Canada) of TM-G707 due to 

command specification differences.  DTSS is ignored.

MCP-V7 (*.v7) TM-V7A

Only for U.S.A. and Canada models.

Unable to use other than K-type (U.S.A. and Canada) of TM-V7 due to 

command specification differences.  DTSS is ignored.

MCP-G71 (*.71) TH-G71A

Only for U.S.A. and Canada models.

Unable to use other than K-type (U.S.A. and Canada) of TH-G71 due to 

command specification differences.



9 MCP-2A Memory Control Program (for use with TM-V71A/E, TM-D710A/E, RC-D710)

74 CONTENTS TM-D710A/E

9.5 Other Functions

9.5.1 Basic Functions

Using MCP-2A, it is possible to configure almost all transceiver functions as were configured with 

MCP-1A.  And, too, there are unique functions that can only be configured with MCP-2A.

Table 9-4   MCP-2A Basic Functions Table

Note: Train channels are available only for J-type (Japan) and Weather channels are available only for K-type (U.S.A. and 
Canada)

9.5.2 Memory Channels

9.5.2.1 Memory Channels

It is possible with TM-V71A/E and TM-D710A/E to configure even those memory channels created 

with MCP.  In addition, for the usual memory channels, arranging the order of channels via a 

sorting feature can be done.

9.5.2.2 Weather/ Train Channels

It is possible to program train channels, if using a J-type (Japan) transceiver model; or you can 

program weather channels, if using a K-type (U.S.A. and Canada) transceiver model.

9.5.2.3 EchoLink Memory Channels

It is possible with TM-V71A/E and TM-D710A/E to configure even those EchoLink channels 

created with MCP.

Category Summary of Functions

Memory Frequencies
Memory channels, Program Memory channels, Call channels, Train channels/ Weather 

channels, VFO frequencies

DTMF Memories DTMF/ EchoLink memories

Menu Settings Transceiver menu, Band mask, Variable levels for data terminal, SQC logic and others

Unique Functions
Import / Export, increasing character size, verifying radio states, indicating user’s name/

callsign
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9.5.3 Menu Settings

9.5.3.1 Transceiver Menu > EchoLink RX Monitor

When using the transceiver in EchoLink Sysop mode, output from the speaker and output to the 

data terminal can be configured.  This function is only possible to configure with the MCP-2A.

9.5.3.2 Transceiver Menu > Repeater Mode (K-type only)

It is possible to configure the transceiver as a cross-band repeater.  When the transceiver is 

configured to be a repeater, there is a function that transmits the repeater’s own ID.  You can 

configure the ID transmission method and choose between Off, Morse code or Voice.  When 

Voice is selected, it is necessary to install the optional VGS-1 Voice Guidance and Storage unit.  

The combined use of cross-band repeater with the external remote function is not possible.  The 

cross-band repeater function is only available on a K-type (U.S.A. and Canada) model.

9.5.3.3 Transceiver Menu > Password

It is possible to configure the character string for the password.  This function is only possible to 

configure with the MCP-2A.  

9.5.3.4 Transceiver Menu > 10MHz Mode

Configure whether you will use the 10 MHz step variable function.  

9.5.3.5 Transceiver Menu > TM-D710A/E

This item can only be configured with TM-D710A/E.  

9.5.3.6 Transceiver Menu > RC-D710

This item can only be configured with RC-D710.  

9.5.3.7 Transceiver Menu > Variable Level of Data Terminal

It is possible to configure the input sensitivity of the external equipment terminal for data 

communications and the output level.  The settings are differentiated between TM-V71A/E, 

TM-D710A/E and RC-D710.

9.5.3.8 Transceiver Menu > SQC Output Logic

It is possible to configure the output logic of the external output terminal (active level) that is used 

for data communications, etc.  Normally, EchoLink Sysop mode uses the “High” configuration.

For details, refer to 8.5.4 Using MCP-2A to Connect TM-D710A/E.
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9.5.4 Unique Functions

9.5.4.1 Importing TravelPlus for Repeaters Files

It is possible to read a file that was exported from TravelPlus for Repeaters sold by ARRL.  A file 

from TravelPlus for Repeaters has a different file extension and format depending on the year it 

was created.  MCP-2A requires the “tpe” extension (2005-2006 edition; version 9.0).  But if it is 

acceptable to you to be able to read only a portion of the file, then the file can be read if a .csv 

extension is applied.  Refer to the MCP-2A Help file for details of how to read this type of file.

Note: The method of storing the On/ Off status and frequency for Tone/CTCSS was modified at the time of MCP-2A, Version 
3.00.

� In the case that “100.0” is displayed in the CTCSS column in the file:
Up to Version 2.01: Turn CTCSS On and configure CTCSS frequency for “100.0 Hz”.
Version 3.00 and later: Turn Tone On and configure Tone frequency for “100.0 Hz”.

� In the case that “67.0/100.0” is displayed in the CTCSS column in the file:
Up to Version 2.01: CTCSS status and CTCSS frequency are set at initial values.
Version 3.00 and later: Turn Tone On and configure Tone frequency for “67.0 Hz”.

9.5.4.2 Importing .hmk Files

It is possible to import a file that was created using Kenwood .hmk format.

9.5.4.3 Exporting .hmk Files

It is possible to export a file that was created using Kenwood .hmk format.  Refer to the MCP-2A 

Help file for details as to how to use a .hmk file that was imported as explained in Section 9.4 

Importing .hmk Files Created by Another MCP-2A.

9.5.4.4 Exporting .html Files

It is possible to export a file with .html format.  

9.5.4.5 Splash Window

You can switch the Splash window On or Off while you are operating.

Note: You can cancel the Splash window temporarily by double-clicking it while it is visible.
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9.5.5 Useful Functions

9.5.5.1 Verifying Firmware Versions

First, connect the transceiver or operation panel to the computer, and then turn the transceiver or 

operation panel ON.  Select “Product Information” from the Model dropdown menu.  The 

transceiver firmware version will appear on the MCP-2A.

Note: To confirm the firmware version of the TNC microprocessor, the firmware version of the operation panel must be 2.00 
or later and “APRSxx” or “NAVITRAxx” must be shown on the display.

9.5.5.2 Increasing Size of Characters

Using MCP-2A, select from three sizes of characters with “Font” in the View pulldown menu.

Note:

Use an Operating System function to change the size of characters on the Menu bar.

If you configure the font size for other than 96 dpi for the Menu bar and also select a font other than Normal for MCP-2A, 

some of the displayed items may not fit within a window.

9.5.5.3 Configuring the Names for PM or Memory Groups

It is possible to configure the name for each memory with “Memory Group Name” or 

“Programmable Memory Name” in the Setup pulldown menu.

9.5.5.4 Configuring User Names with MCP-2A

It is possible to configure the user’s name or callsign with “Callsign Setting” in the Setup pulldown 

menu.  The character string that is input is shown in the About MCP-2A window, in the Title bar 

and in the Splash window when the software starts.  In addition, when the Start sending the 

Morse code checkbox is checked, the character string configured will be played back using Morse 

code when the software starts.

Note: Depending on your particular computer used, it may not be possible to play back Morse code.

9.5.5.5 Configuring How Memory Channels Display

Using “Range of Standard Memory Channel” in the Setup pulldown menu, it can be configured 

whether memory channels are displayed for configuration in groups of 100 or whether all memory 

channels are displayed in one window.



9 MCP-2A Memory Control Program (for use with TM-V71A/E, TM-D710A/E, RC-D710)

78 CONTENTS TM-D710A/E

9.5.5.6 Memory Channel Shortcut

The memory channel shortcut can be used as follows:

� Double-click “Free Memory Channel: xxxx/1000” on the Status bar (see Figure 9-8).  

The Memory Channel window will appear.

The memory channel shortcut can be used as follows:

Furthermore, if the following action is done, the configuration window will open to allow 

configurations to be entered:

� Double-click “Offset/ Tx Freq.”, “Plus/ Minus Shift/ Split”, “T/CT/DCS” sections on the Status bar 

(see Figure 9-8) to edit the channel configurations.  The Channel Edit window will appear.

Figure 9-8   Memory Channel Shortcut

9.5.5.7 COM Port Shortcut

Double-click the “COM x” or “bps : xxxx” sections on the Status bar (see Figure 9-8).  The COM 

Port Setting window will appear.
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10  HOW TO UPDATE FIRMWARE

10.1 Firmware

This section describes the TM-D710A/E or TM-V71A/E transceiver itself, the TM-D710 operation 

panel and how to update the firmware of RC-D710 and the TNC.  Those using TM-D710A/E and 

RC-D710 previously and who would like to utilize the SmartBeaconing and enhanced QSY 

functions which was added to APRS must update the firmware.

10.2 Verifying Necessary Equipment

In order to update the equipment, each of the following is required:

� Equipment to be updated (TM-D710A/E, TM-V71A/E, or RC-D710)

� Computer

� Communication cable (PG-5G or PG-5H)

� Firmware update program

Kenwood provides the firmware update program for use on Windows operating systems.  The 

specifications for your computer in order to use this software are as shown in Table 10-1.

Table 10-1   Firmware Update Computer Specifications Table

Note: 

If using Windows Vista, it is not necessary to install the run-time environment specified above.  Otherwise, if Microsoft .NET 

Framework 2.0 (or later) is not installed, download the software from the following URL and install it prior to installing 

MCP-2A:  http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-

aab15c5e04f5&displaylang=en

Use the following procedure to determine if Microsoft .NET Framework 2.0 (or later) is installed on your computer.  The 

example shown is for Windows XP.

Click “Start” > “Control Panel” > “Add or Remove Programs”.  You should see “Microsoft .NET Framework 2.0” (or later) in 

the list of installed software.

While updating the firmware, the transceiver or panel may be fully reset.  If you do not wish to lose the memory contents 

and configurations, save the current configuration data to a file prior to updating the firmware.

Depending on the type of computer, there may not be any equipped COM ports.  In this case, you will need a USB-to-serial 

port conversion cable.

Personal Computer Required Specification

Operating System Windows 2000 (SP4 or later), Windows XP (SP2 or later), Windows Vista (32-bit version)

CPU CPU recommended by OS or faster

Memory Larger than OS recommended capacity 

Run-time 

Environment
.NET Framework 2.0 or later (see Notes below) 

Communication Port Serial port available (COM1 to COM20). (see Notes below)

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en
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10.3 How to Verify Firmware Version

You can verify the firmware version by the procedure below.  Use one of the following two ways of 

verifying.

10.3.1 Checking the Transceiver Operation Panel

1. Press [TNC] on TM-D710A/E or RC-D710 to display “APRSxx”.

(Skip this step for TM-V71A/E)

2. Turn the power OFF.

3. Hold [ ] and [PF1] down and turn the power ON.

4. Verify the following is displayed.

� Number on left side of display: Indicates the firmware version of the transceiver itself.

� Number on right side of display: Indicates the firmware version of the operation panel.

� Number at upper right side of display: Indicates the firmware version of the TNC.

Figure 10-1   Verifying Firmware Versions

Note:

The firmware version number appears on left side of the display for TM-V71A/E.

The firmware version of the operation panel must be 1.12 or later to display the firmware version of the TNC 

microprocessor on the operation panel display.

10.3.2 Checking with MCP-2A

1. Press [TNC] on TM-D710A/E or RC-D710 to display “APRSxx”.

(Skip this step for TM-V71A/E)

2. Turn the power OFF.  For TM-D710A/E, connect the communication cable to the transceiver 

itself.

For RC-D710, connect the communication cable to the front panel.

3. Turn the power of the transceiver or RC-D710 ON.

4. Start MCP-2A and select “Product Information” from the Model pulldown menu.

Figure 10-2   Verifying Firmware Versions

Note: The firmware version of the operation panel must be 2.00 or later to use MCP-2A to display the firmware version of the 
TNC microprocessor.
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10.3.3 Firmware Update for SmartBeaconing and Other Enhancements

New firmware is required to use the SmartBeaconing function in the following cases: 

� If transceiver and controller version is older than Version 2.00

10.4 How to Get Newest Firmware/Software

Download the newest version of update software from the Kenwood web site URL shown below 

(URL is subject to change).

http://www.kenwood.com/i/products/info/amateur/software_download.html

10.5 How to Update 

Carefully read the update instructions provided when you download the software.  Begin the 

procedure only after you understand the provided instructions.

Table 10-2   Firmware Update Summary Table

Note:

During a routine update, there are times when automatic resets are executed.  Therefore, ensure you back up all values 

and channel data prior to beginning the firmware update.

To restore the backup data, confirm all data is correct using on MCP-2A prior to writing data back to the transceiver.

Item to Update Files Required Remarks

Transceiver TM-V71_TM-D710_Main_VxxxE.exe
The updater file can also be used for 

TM-V71A/E.

Operation Panel TM-D710_RC-D710_OpPanel_VxxxE.exe The updater file can also be used for RC-D710.

TNC TM-D710_RC-D710_Tnc_VxxxE.exe

Operation panel’s firmware must be Ver. 1.12 

or newer.

The updater file can also be used for RC-D710.

http://www.kenwood.com/i/products/info/amateur/software_download.html
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11  MISCELLANEOUS TOPICS

11.1 RC-D710 
(Operation Panel / APRS-ready Standalone TNC)

It is possible to replace the TM-V71A/E’s front panel with RC-D710 and upgrade your TM-V71A/E 

to be functionally equivalent to TM-D710A/E.  RC-D710 can function as the operating panel of 

TM-D710A/E.  In addition, if RC-D710 is connected to another transceiver via the optional PG-5J 

interface kit, this produces an APRS-ready standalone TNC.

11.1.1 Models Supported for use with RC-D710

The following models are supported to be used with RC-D710: TM-V71A/E, TM-D710A/E, 

TM-D700A/E, TM-V708A, TM-G707A/E, TM-V7A/E, TM-733A/E, TM-255A/E and TM-455A/E.  

Excluding the situations of using RC-D710 as an operation panel for TM-V71A/E and 

TM-D710A/E, the optional PG-5J interface kit is necessary.

Note: 1200/9600 bps data communications functionality is possible via the 6-pin mini-DIN connector.  However, this type of 
data operation cannot be guaranteed for these transceivers.  Furthermore, when RC-D710 is connected to equipment 
other than the above mentioned transceivers, Kenwood cannot support nor offer an opinion as to whether such 
configurations will function.

11.1.1.1 Connection Example 1: Connecting RC-D710 to TM-V7A/E

Figure 11-1   Connecting RC-D710 to TM-V7A/E

RC-D710 Modular plug cable

Line filter

PG-5J
Black (-) 

cable
Red (+) 
cable

DC power cable
6-pin mini-DIN cable 

DATA terminal

Panel jack

Panel jack

To 13.8 V DC power supply

or 12 V vehicle battery  

DATA terminal

Transceiver

Line filter
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11.1.1.2 Connection Example 2: Connecting RC-D710 to TM-D700A/E, TM-V708A

Figure 11-2   Connecting RC-D710 to TM-D700A/E, TM-V708A

Note: Excluding the situation of using the RC-D710 as the operating panel for TM-V71A/E or TM-D710A/E, the RC-D710 
cannot operate transceivers.  Be sure to connect the control panel of the transceiver to the transceiver itself.

11.1.1.3 DATA Terminal Pins (PG-5J)

Table 11-1   DATA Terminal Pins (PG-5J) Table

No. Name
Input/ 

Output
Function

1 PKD Output

TNC data output

2Vp-p/10kΩ (9600 bps)

40mVp-p/10kΩ (1200 bps )

2 GND - GND

3 PKS Output

Data standby control signal output

Open collector

TX: Low level / RX: High impedance

4 PR9 Input
TNC data input (both for 1200 bps and 9600 bps)

350mVp-p to 600mVp-p/10kΩ

5 NC - No connection

6 SQC Input
Squelch control signal input (5V CMOS level)

SQL Open: High level / SQL Close: Low level

RC-D710 Modular plug cable

PG-5J
Black (-) 

cable
Red (+) 
cable

DC power cable
6-pin mini-DIN cable 

DATA terminal

Panel jack

Panel jack

To 13.8 V DC power supply 

or 12 V vehicle battery  

DATA terminal

Transceiver

Line filter

Line filter

NC

PKS

PKDGND

SQC

PR9
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11.2 Adjusting Input and Output Levels

When a transceiver, other than those that have been verified to operate correctly, is connected, 

there are times when adjustment of input/output levels may become necessary for RC-D710 and 

the transceiver to function properly.  Even when you cannot adjust the input and output levels on 

the transceiver side that is connected, it is possible to adjust input and output levels on 

the RC-D710 side using 3dB steps by using MCP-2A.

11.2.1 How to Configure Input/Output Levels of RC-D710

1. Turn the power of RC-D710 OFF.

2. Connect the PG-5G programming cable (serial communication cable) between the COM 

terminal on the rear side of RC-D710 and a personal computer.

3. Start MCP-2A.

Click the “ ” button on MCP-2A and read the data from RC-D710.

4. Select “Data Terminal” from the Edit pulldown menu.

The configuration window for input/ output levels will open.

Figure 11-3   Data Terminal Window

PKD PIN (1200bps): 1200 bps output level

PR9 PIN (1200bps): 1200 bps input level

PKD PIN (9600bps): 9600 bps output level

PR9 PIN (9600bps): 9600 bps input level

* Input / output terminals for 1200 bps and 9600 bps are the same.  However, levels have to be set individually.  
Refer to the Help file for MCP-2A for details.

5. Click the “ ” button on MCP-2A and write the data to RC-D710.

6. Turn the power of RC-D710 OFF and disconnect the programming cable from PG-5G.

Note: In some transceivers, other than those that have been verified to operate correctly, the TNC data input/output line 
which is connected to PKD/PR9 has not disconnected the DC voltage inside the transceiver.  Therefore, there are 
situations where the transceiver will not function properly even if input/output levels are adjusted correctly.  Use 
caution.
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11.3 Schematic Diagram of the Optional 
PG-5J Interface Kit

Figure 11-4   PG-5J Schematic Diagram

11.4 AvMap (written by Don Arnold, W6GPS) 

The TM-D710A/E uses the NMEA 0183 standard at 4800 and 9600 baud rates to communicate 

with the GPS unit.  The transceiver has three formats for interfacing to GPS units: NMEA, 

Magellan and the new Kenwood format.  A GPS system with a serial interface will connect to the 

TM-D710A/E but if your GPS supports bi-directional communication, it is possible to have APRS 

callsigns and icons appear on the GPS screen.  Of all the name brand GPS units, the AvMap G5 

smoothly interfaces with the Kenwood TM-D710A/E TNC better than any other with less 

adaptation and more features specific to APRS and the TM-D710A/E by taking advantage of the 

Kenwood APRS sentence and providing a Kenwood interface cable for truly Plug and Play 

operations.

Note: The baud rates refer to serial communication between transceiver and GPS and not to the AX.25 Packet 
communication between transceivers.

AvMap G5 has many of the normal Personal Navigator data fields that you would find in most 

world brand GPS units, but AvMap developers have integrated the Kenwood sentence format to 

provide you a Tactical Mode.  No other standalone GPS system has this exclusive Kenwood/

AvMap feature.  If you are involved in a search and rescue scenario, you can assign one of your 

APRS assets (callsigns) the target designation for Tactical Mode.  This designated callsign on 

each position report is processed by AvMap for easy viewing and tracking.

If you are using the TM-D710A/E with the AvMap, in Tactical mode, you will get an additional five 

data fields that can be displayed on your AvMap:
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Target ID - Callsign

Target Lat Long

Target SOG - Speed over Ground

Target COG - Course over Ground

Target Altitude - Mean -sea-level

Figure 11-5   AvMap G5 and TM-D710A/E

You can choose three of these five data fields to display on the AvMap screen.  So, when your target 

callsign is moving, you can get real time information and a visual display on the AvMap G5.  

A stationary callsign is displayed on the AvMap screen as a blue circle, if the mark moves more that 

200 meters on a new report, AvMap creates a moving target or red triangle designator.

Recently added to the AvMap operating system is now full APRS icon represention.  The decoded 

APRS packet from the Kenwood TM-D710A/E (in Kenwood waypoint format) is processed by the 

AvMap G5 operating system.  When the mark is made on the screen, it now can be one of over 100 

standardized APRS icons along with the callsign.

Setup of the Kenwood transceiver with AvMap is very simple.  Using the defaults of the Kenwood 

transceiver, only a few menu configurations are needed to set up the TM-D710A/E.

Menu 600: (BASIC SETTINGS):

MY CALLSIGN:  Your callsign and “-9”. (such as “W6GPS-9”)

Menu 602: (GPS PORT)

BAUD RATE:  9600 

INPUT: GPS

OUTPUT:  WAYPOINT

Menu 603 (WAYPOINT):

FORMAT:  KENWOOD

NAME:  9-CHAR

Menu 611: (BEACON TX ALGORITHM)

METHOD:  AUTO or SmartBeaconing
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Press [TNC] on the operation panel of transceiver (“APRS12” should appear on the display).

Note: For a more detailed setup of APRS and the options available, see section 3 PREPARATIONS FOR USING APRS of 
AvMap G5 owner’s manual.

With the AvMap G5, the only thing needed is to verify in the setup menu that the interface is 9600 

APRS.  The 3-pin plug is inserted into the TM-D710A/E GPS port of the operation panel and the 

4-pin connection to the TMC port of the AvMap G5.  In no time, you will see APRS activity on your 

AvMap screen.

APRS activity is stored in the APRS subfolder of the contacts folder for easy reference so you can 

navigate to it or monitor a particular APRS callsign in Tactical Mode.  With the Kenwood 

TM-D710A/E and AvMap G5, there is no need to mess around with USB to serial converters nor is 

there need for a cumbersome computer.  Also, the serial input to the TM-D710A/E is on the 

operation panel, so it is close to the GPS receiver for a neater installation.
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12  Appendix

Revision History

Date Remarks

May 1, 2008 Initial release only for printing purposes.

May 16, 2008

Revision 1.01 is released for web download.

1) Added revision number and date on the back cover.

2) Added Revision History.

3) Fixed typos in 1.2 Evolving Development, 1.3 Affinity with VoIP, 

2.1.3 Mobile Information Resource, 2.2 Ubiquitous Operations, 

4.1.2.1 GPS and APRS Position Format, 5.1.3 Creating a CMD File for TM-D710A/E, 

3.1 What Do I Need to Configure, 3.2.3 BEACON TYPE, 

6.1.1.1 Automatic Reply Function, 6.1.2 Decay Algorithm Function, 

6.1.3 Proportional Pathing Function, 6.1.5.3 Operation Example, 

6.1.6.1 Transmitting QSY Information, 6.1.6.2 Receiving QSY Information, 

7.3.1 Sending Email with TM-D710A/E and RC-D710, 

7.4 Digipeaters (Digital Repeaters), 7.4.1 UIDIGI, 7.4.2 UIFLOOD, 7.4.3 UITRACE, 

7.5.3 STATE/ SECTION/ REGION, 8.1 What is EchoLink?, 

9.2.2 Useful Functions of MCP-2A, 9.3 Importing Other MCP Files into MCP-2A, 

10.1 Firmware, 10.2 Verifying Necessary Equipment, 

11.1.1 Models Supported for use with RC-D710 and 11.4 AvMap.

4) Revised the descriptions in Amateurs Building the New Global Communications 

Network, 2.2 Ubiquitous Operation, 2.4 Kenwood Contributions, 

3.1 What Do I Need to Configure, 3.2.1 Built-in Clock, 3.2.3 BEACON TYPE, 

4.1 What is GPS?, 5.1.3 Creating a CMD File for TM-D710A/E, 

6.1.6.1 Transmitting QSY Information, 7.4 Digipeaters (Digital Repeaters), 

7.5.1 New-N Paradigm, 7.6 Using APRS and EchoLink Simultaneously, 

8.1 What is EchoLink, 9.1 Downloading and Installing MCP-2A, 

9.5.5.6 Memory Channel Shortcut, 10.2 Firmware, 10.2 Verifying Necessary Equipment, 

10.3.3 Firmware Update for SmartBeaconing and other enhancements, 

10.5 How to Update, 11.1.1.2 Connection Example 2: Connecting RC-D710 to 

TM-D700A/E and 11.4 AvMap.

5) Revised Figure 3-2, Figure 6-8, Figure 6-9, Figure 6-10, Figure 7-3, Figure 7-5 

and Figure 7-8. 
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